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Monitoreo de proyectos 

 
Los proyectos enlazados pueden ser monitoreados y coordinados. Estas opciones son 
útiles cuando los equipos de ingenieros y arquitectos necesitan trabajar en un único 
modelo de edificio. Una apropiada coordinación y monitoreo es necesaria  para reducir 
errores y omisiones. Un monitoreo efectivo asegura que cualquier miembro del equipo de 
trabajo pueda modificar los elementos del diseño y estas modificaciones puedan ser 
observadas por sus compañeros. 
 

Funcionamiento de las herramientas de colaboración 
 
Colaboración en un proyecto envuelve, la liga de archivos, copiar elementos de un 
proyecto a otro  estableciendo  relación entre los elementos, además se debe monitorear 
los cambios hechos a los elementos.  
 
Copy/Monitor 
 
Para que la colaboración entre proyectos sea eficiente, es necesario importar y enlazar 
proyectos externos a un proyecto máster. El comando Monitor Tool carga y monitorea las 
relaciones establecidas entre elementos y los cambios. 
 
Cuando los elementos son copiados con la herramienta Copy/Monitor tool, se crea 
automáticamente una relación entre los elementos en el archivo ligado y las copias de los 

elementos en el archivo máster. Un símbolo  es desplegado sobre los elementos para 
indicar que estos están siendo monitoreados. 
 
Cuando se modifica un objeto monitoreado una alerta es desplegada para indicar los 
cambios.  
 

 
Figura 1 

 
Los objetos que pueden ser monitoreados son paredes, niveles, pisos y rejillas (Grid). La 
caja de dialogo Copy/Monitor Options, mostrará información acerca de los objetos del 
proyecto ligado seleccionado, además permitirá cambiar algunas propiedades de los 
objetos cuando estos sean copiados al proyecto máster. Por ejemplo;  
 

 En las paredes, el parámetro Copy Windows/door/Opening, puede desactivarse 
para que la pared sea copiada sin ninguno de estos elementos. También se puede 
copiar la pared al proyecto máster cambiando el tipo, esto se realiza desde la 
columna New Type.  
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Figura 2 

 

 En los pisos, puede desactivarse el parámetro Copy Openings/inserts, para 
copiarlo al proyecto máster sin ninguno de estos elementos, igualmente puede 
cambiarse el tipo de piso. 

 Para los niveles se puede crear las copias a una altura distinta a la original, 
usando la opción Offset level, si existen niveles que coinciden en elevación con el 
proyecto máster, entonces se usaran los del proyecto máster y las copias no serán 
creadas (esta opción se encuentra en la casilla Reuse matching levels, que por 
defecto esta desactivada). 

 En las rejillas (Grids) si existen rejillas que coinciden en la misma ubicación del 
proyecto máster, entonces se usaran las rejillas del proyecto máster y las copias 
no serán creadas (esta opción se encuentra en la casilla Reuse matching grids, 
que por defecto esta desactivada). 

 
Coordination Review 
 
Cuando un elemento monitoreado es modificado, el comando Coordination Review puede 
ser utilizado para revisar las alertas y decidir qué acciones tomar, con respecto a las 
modificaciones realizadas. 
 
Guía para monitorear y coordinar proyectos ligados 
 
A continuación se indican algunas recomendaciones para coordinar y monitorear 
proyectos de forma eficiente: 
 

 Use el comando Copy/Monitor para hacer seguimiento de los cambios hechos a 
los proyectos sobre elementos tales como paredes y pisos, y compartir reportes y 
revisiones con el resto del equipo, para asegurarse que el equipo entero está 
trabajando sobre la misma información. 

 SE puede usar Copy/Monitor en vez de crear Worksets. Esto es porque el 
comando Copy/Monitor  no requiere definir un archivo centralizado y es más fácil 
de usar las funciones de este comando, que crear un workset. 

 Copy/Monitor no garantiza que los cambios realizados en los elementos sean 
reportados inmediatamente a la persona quien coloca los ítems en el archivo 
ligado, en cambio puede utilizar  el comando Coordination Review/report, para 
revisarlos y hacer un seguimiento de los cambios. 
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 SE puede ligar tantos proyectos como se requiera a un proyecto máster. Sin 
embargo esto puede bajar el rendimiento de Revit. Entonces una vez que use 
Copy/Monitor sobre un archivo ligado, vuelva a cargar el enlace periódicamente 
para revisar las alertas relacionadas con los cambios. 

 
Para copiar objetos desde un proyecto ligado al proyecto máster: 
 

1. Realizar la liga de un proyecto a un proyecto máster 

2. Activar la pestaña Collaborate => Panel Coordinate => Desplegar icono  

Copy/Monitor  =>  (Select link) 
3. Hacer un clic sobre el proyecto ligado 
4. En caso de que se requiera verificar las propiedades de los objetos que van a 

seleccionarse para ser monitoreados. Escoger en la pestaña Copy/Monitor => 

Panel tools =>  
5. Se despliega la caja de dialogo de opciones Copy/Monitor 
 

 
Figura 3 

6. Escoger en la pestaña Copy/Monitor => Panel Tools =>   (Copy) 
7. Seleccionar los objetos  a copiar 

 
Figura 4 

 

 Se despliega el símbolo  que indica que el objeto está siendo monitoreado. 
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8. Escoger en el panel Copy/Monitor  =>  (Finish) 
 
Cuando un elemento que ha sido copiado con el comando Copy/Monitor es seleccionado, 
este muestra el símbolo que indica que está siendo monitoreado. 
 

 
Figura 5 

 
Para parar el monitoreo de un objeto: 
 

1. Seleccionar el objeto que está siendo monitoreado 

2. Escoger la pestaña Modify (wall, floor, level, grid) => Panel Monitor =>  (Stop 
Monitoring) 
 

Para revisar y reportar los cambios de los elementos que están siendo monitoreados: 
 

1. Escoger la pestaña collaborate => Panel Coordinate => desplegar icono  

(Coordination Review) =>  
2. Escoger el proyecto ligado que tenga los elementos monitoreados 
3. Se despliega el cuadro de dialogo Coordination Review, el cual muestra un listado 

de todos los cambios gestionados sobre los elementos. 
4. Presionando el botón Create Report, se genera un reporte en formato HTML. 
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Figura 6 
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Colaboración y opciones de diseño 

 
Se puede crear fases en el diseño de un edificio, los cuales permiten subdividir un 
proyecto en diferentes periodos de construcción y manejar el ciclo de vida del proyecto. 
También se pueden crear opciones de diseño en cada fase que posibilitan a los 
arquitectos evaluar y rediseñar  los modelos en un solo archivo de proyecto. 
Adicionalmente, las herramientas de análisis, permiten verificar y detectar interferencias 
en todas las instancias del modelo. 
 

Fases de proyecto 
 
Revit Architecture maneja dos tipos de fases, existentes y construcción nueva. Cuando se 
diseña un nuevo edificio, generalmente es referido automáticamente a la fase existente. 
En cambio los proyectos de remodelación o nuevas construcciones sobre el modelo  se 
deben definir en fases donde se pueda documentar los cambios a medida que avanzan 
los trabajos. Utilizando fases será posible consultar en cualquier momento, como ha ido 
cambiando el proyecto, desde el inicio hasta el final. 
 
Definición 
 
Las fases representan periodos de tiempo fijos en el proyecto. Se puede especificar en un 
proyecto tantas fases como sean requeridas. En un proyecto de renovación por ejemplo 
puede tener una fase de demolición y varias fases de reconstrucción. También se pueden 
crear fases existentes  para representar el estado actual del proyecto. 
 
Las fases de un proyecto se representan en vistas. Cada vista modelo incluye el reporte 
(visualización de elementos) perteneciente a esa fase. Los filtros de fases controlan cual 
fase o fases aparecen en la vista. 
 
Los elementos pertenecientes a una fase aparecen con un tipo de línea diferente, para 
que puedan ser diferenciados.  La apariencia de los elementos pertenecientes a una fase 
se controla con la opción “Graphics overrides” para fases. Esta opción permite la 
combinación de varias fases en una vista, acorde a los requerimientos. 
 
La figura a continuación muestra una vista donde se combina la visualización de los 
componentes existentes (en color gris) y los componentes demolidos (en color rojo). 
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Figura 7 

 
Propiedades de una fase 
 
Cada vista tiene dos propiedades Phase y Phase Filter.  
 
La propiedad de fase inicialmente controla la fase de componentes creados o colocados 
en las vistas. Cuando una vista es creada o abierta, un valor de fase es automáticamente 
asignado a la vista.  
 
La apariencia de los componentes de un modelo, cambia cuando se aplica un filtro de 
fase a una vista. Por ejemplo, las paredes demolidas pueden desaparecer o aparecer en 
línea punteada en la vista actual, esto de acuerdo a la representación especificada para 
los objetos demolidos. 
 
La propiedad de fase puede ser cambiada en cualquier momento, así, si un componente 
es creado en una vista de fase 1 y este es demolido en una vista de fase 2, el 
componente aparece como nuevo en la vista de fase 1 y como demolido en la vista de 
fase 2. Por defecto los proyectos nuevos tienen definidas dos fases; Existing y New 
Construction. 
 
Filtros de fases 
 
Un filtro de fase, es una regla que controla la apariencia de los componentes del modelo 
en una vista. Esto determina las fases que serán desplegadas en una vista y su 
apariencia. 
 
Se puede definir las fases y los filtros de fases para las vistas de un proyecto y  además 
hacer múltiples copias de una vista y aplicar diferentes fases y filtros de fases  para las 
copias de la vista. 
 
Para desplegar todos los componentes de todas las fases del proyecto, se debe 
configurar los filtros de fases en Show All. Para desplegar todos los componentes del 
modelo sin las configuraciones “Graphics overrides”, es decir el valor de los filtros de 
fases debe estar en  None. 
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Los filtros de fases que están configurados por defecto en cada proyecto son: 
 

 Show All: despliega los componentes nuevos, existentes, demolidos y temporales 
en la fase actual. Los componentes de demolición en fases anteriores no se 
despliegan. 

 Show Demo + New: despliega componentes nuevos y demolidos 

 Show previous + Demo: despliega componentes existentes y demolidos 

 Show previous + New: despliega componentes existentes y nuevos 

 Show previous Phase: despliega todos los componentes de la fase anterior 

 Show New: despliega los nuevos componentes 

 Show Complete: despliega componentes existentes y nuevos; esto significa el 
proyecto completo. 

 
Condiciones de fases 
 
Las fases de un modelo tienen asociadas las siguientes condiciones: 
 

 New: el componente es creado en la fase de la vista actual. 

 Existing: el componente es creado en una fase anterior y sigue existiendo en la 
fase actual. 

 Demolished: el componente es creado en una fase anterior y demolida en la fase 
actual. 

 Temporary: el componente es creado en la fase actual y demolida en la misma 
fase. Esto significa que ha sido creado temporalmente. 

 
Cada condición de filtro de fase tiene las siguientes opciones de visualización: 
 

 By category: despliega los componentes, tal como están definidos en 
Visibility/Graphics en el estilo de objeto. 

 Overriden: Despliega los componentes tal como están definidos en la pestaña 
Graphics Override, en la caja de dialogo de fases. 

 Not Displayed: no despliega componentes  
 
Aplicando fases a reportes de cuantificación 
 
Las fases y los filtros de fases se aplican automáticamente a los reportes. Por ejemplo, en 
un proyecto que ha tenido una remodelación muy grande, se pueden generar varios 
reportes uno antes de la remodelación y otro después de la remodelación 
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Figura 8 

 
Mejores prácticas para trabajar con fases en un proyecto 
 
Las siguientes son las recomendaciones para trabajar con fases en un proyecto: 
 

 Se recomienda crear fases cuando los proyectos involucran cambios constantes 
en el diseño (remodelaciones, demoliciones etc). Entonces es mejor crear una 
plantilla de proyecto en la cual se configuren las vistas de planta para trabajar con 
una fase existente (existing phase). 

 Trabajar al unísono con fases, filtros de fases, graphics overrides y vistas, para 
que la representación del modelo sea correcta. Las condiciones de los filtros de 
fases están definidos para cubrir las necesidades de representación de las fases 
de un proyecto. Sin embargo estas pueden ser cambiadas para adaptarlas a las 
necesidades específicas del proyecto. 

 Las dos fases definidas por defecto (Existing y New Construction) son suficientes 
para representar demoliciones en un proyecto simple, no es necesario crear una 
fase de demolición. Los objetos demolidos en una nueva construcción podrán 
ocultarse o ser visualizados usando los filtros de fases. 

 La opción “Graphics Overrides” para fases es fácil para aplicar y remover, y 
también trabaja globalmente para todas las vistas. Adicionalmente esta función se 
puede usar para cambiar vistas individualmente en un proyecto. 

 Para los proyectos en los que se hace complicado manejar fases, se recomienda 
configurar las fases en las vistas cuando se está indiciando el diseño. Luego podrá 
agregar o eliminar fases a medida que se vaya avanzando en el desarrollo 
entonces, esto hará más fácil manejar múltiples fases de demolición, porque ya 
han sido configuradas en forma temprana las fases. 

 
Para revisar la propiedad de fase en una vista: 
 

1. Abrir la vista requerida 
2. Ingresar a las propiedades 
3. Bajo la sección Phasing, están las propiedades de fase activas para la vista 

seleccionada. 
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Figura 9 

 
Para crear una fase: 

1. Escoger pestaña Manage => Panel Manage Project =>  (phases) 
2. Se despliega la caja de dialogo de fases. Las fases se crean en la pestaña Project 

Phases 
 

 
Figura 10 

 

3. Las fases deben ser creadas en un orden estricto, por lo tanto; si se quiere crear 
una fase de demolición, esta debe ir después de la fase Existing, entonces debe 
seleccionar la fase Existing tal como se ve en la figura y presionar el botón After. 

 

 
Figura 11 

 
Entonces la nueva fase será creada inmediatamente después de la fase Existing, y 
antes de la fase New construcción. 
 

Para verificar los filtros de las fases: 
 

1. En la caja de dialogo de Phasing, activar la pestaña Phase Filters 
2. Para revisar o cambiar las opciones de visualización de los filtros, se debe 

desplegar la condición requerida.   
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Figura 12 

 
Para definir las propiedades de visualización de los objetos en las condiciones existentes: 
 

1. En la caja de dialogo Phasing, activar la pestaña Graphics Overrides 
2. Bajo el título Phase Status, se  listan las condiciones de los filtros de las fases 
3. Cambiar las propiedades de color, sombreado, tipo de línea o grosores de línea, 

requeridos para el proyecto. 
 

  
Figura 13 

 
Para cambiar objetos de fase: 
 

1. Seleccionar todos los objetos que requieren cambiarse de fase 
2. Ingresar al cuadro de dialogo de propiedades  
3. En la sección Phasing escoger la fase que se requiere asignar a la vista. 
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Trabajo compartido (worksets) 
 
Revit Architecture facilita el trabajo simultaneo sobre un proyecto, lo cual se realiza 
distribuyendo tareas entre el equipo. Se puede subdividir un proyecto en conjuntos de 
trabajo (worksets) y ponerlos en una localización central en un servidor para activar el 
trabajo compartido  entre los miembros de  un equipo y asegurarse de que el diseño del 
proyecto progresa de manera coordinada.  
 
Un workset es un conjunto de elementos de construcción que pueden ser editados por un 
miembro de un equipo de trabajo, de manera que los otros miembros del equipo pueden 
observar los cambios pero no pueden editar los elementos, lo cual ayuda a prevenir 
errores en la coordinación del trabajo.  
 
Mediante la asignación de elementos a worksets específicos, los miembros de un equipo 
pueden hacer cambios a estos elementos simultáneamente, mientras que otro equipo 
trabaja sobre el proyecto. Cuando un workset individual es grabado en el archivo central, 
los cambios son publicados para el otro equipo de trabajo, activándolos para que puedan 
observarse en el modelo principal. 
 
Proceso para compartir proyectos 
 
El proceso para compartir un proyecto envuelve la activación, creación y división del 
modelo del edificio en worksets. Los miembros de los diferentes equipos editan los 
worksets para trabajar sobre diferentes áreas del edificio. 
 
Los siguientes pasos describen el procedimiento para compartir un proyecto: 
 

1. Iniciar el proyecto con un usuario: un usuario necesita comenzar a trabajar  
sobre un proyecto, incorporando tanto como sea posible los estándares y familias 
que se usaran para el diseño. Además el diseño debe haber alcanzado un nivel 
razonable en el desarrollo, antes de que sea compartido. 

2. Activar worksets: cuando un proyecto va a ser trabajado por múltiples usuarios, 
se necesitará dividirlo en worksets. Una vez que el proyecto está listo para ser 
compartido, se debe activar los worksets. Por defecto Revit tiene creado un 
workset, sin embargo el coordinador del proyecto debe crear los worksets 
adicionales para que el proyecto pueda ser compartido apropiadamente con todos 
los miembros del equipo. 

3. Subdividir el proyecto en worksets: Una vez que los worksets han sido creados, 
los elementos del modelo deben ser  ubicados en sus respectivos worksets. Por 
ejemplo si hay un equipo responsable de colocar las paredes interiores y los 
elementos de construcción correspondientes a estas, entonces se puede crear un 
workset llamado “Interiores”. 

4. Crear un archivo central: El archivo central es automáticamente creado la 
primera vez que el proyecto es grabado después que los worksets han sido 
activados. El archivo central coordina y propaga  los cambios de cada usuario y  
sigue la pista de los worksets disponibles. 

5. Crear archivos locales: Se crea un archivo local por cada miembro del equipo. 
Los archivos locales posibilitan al usuario trabajar en la parte del proyecto que le 
corresponde y realizar las comprobaciones necesarias, para luego guardar los 
cambios en el archivo central. 

http://www.darco.com.mx/


 

16 

DERECHOS RESERVADOS DARCO S.A. DE C.V.  2015 
www.darco.com.mx  

 

6. Abrir worksets: Siempre al abrir un archivo local o central, se tiene la opción de 
escoger el workset para trabajar. Al escoger sólo los worksets que se necesitan 
para trabajar se acortan los tiempos para abrir y grabar los archivos. 

7. Trabajar con worksets: al dar de alta un workset el usuario puede realizar los 
cambios correspondientes a los elementos de este. Los nuevos elementos del 
proyecto serán colocados en el workset que se encuentre activo en el momento.  

8. Grabar cambios: regularmente los cambios son grabados tanto en el archivo local 
como en el central. Para grabar los cambios de manera que otro usuario pueda 
visualizarlos se deberá guardarlos en el archivo central. 

9. Cerrando el archivo local: al finalizar la sesión de trabajo, los cambios deben ser 
guardados en el archivo central. Adicionalmente antes de cerrar el archivo, 
también los cambios deben guardarse en el archivo local, esto garantizará la 
coordinación entre los archivos central y local. 

 
Limitaciones en la edición del archivo central 
 
Solo un miembro del equipo de trabajo puede editar el archivo central. No se debe 
trabajar directamente en el archivo central, a menos que sea el único usuario que se 
encuentra trabajando en el proyecto. Todos los usuarios deben tener una copia local del 
archivo central, trabajar localmente y entonces actualizar al archivo central para que otros 
usuarios puedan visualizar los cambios. 
 
Después de grabar en el archivo central, se crea una carpeta de respaldo que contiene 
cuatro archivos con extensión DAT que son: eperms.dat, request.dat, users.dat, 
wperms.dat. Estos archivos contienen los datos del estatus sobre la edición y dueños de 
los worksets. Estos archivos no deben ser borrados. 
 
Referencias entre worksets 
 
A menudo existe una relación entre elementos en un proyecto, y puede que los elementos 
relacionados pertenezcan a diferentes worksets. Por ejemplo una ventana que está 
referenciada a la pared sobre la cual está colocada, una  pared esta referenciada con otra 
pared con la cual se une. Si las dos paredes se encuentran en diferentes workset, Revit 
crea una referencia entre los dos worksets. 
Los worksets referenciados, son relaciones creadas entre dos worksets, entonces, cuando 
se abre un workset que tiene una referencia a otro, también se abre el workset 
referenciado.  
 
Configuración de worksets 
 
Es necesario que los worksets sean organizados de tal manera que sea posible abrir el 
mínimo de worksets requeridos para hacer el trabajo, esto debido a que la referencias 
entre worksets se hace automáticamente, se puede usar la opción Seleccionar, para 
escoger solo aquellos Worksets que se necesitan. 
 
Los worksets no pueden ser referenciados a un workset específico. Por ejemplo, los 
elementos de un workset que sea usado para muros interiores, probablemente no 
necesitarán ser referenciado a los elementos de un workset de mobiliario. 
 
Para definir el usuario de Revit: 
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1. Abrir Revit. (NO debe tener abierto ningún proyecto) 
2. Desplegar el Menú de aplicaciones 
3. Hacer clic en el  botón Options 
4. En la caja de dialogo de opciones, activar la pestaña General 
5. En la casilla Username, escribir el nombre de usuario con el cual se identificara en 

el grupo de trabajo que tendrá acceso al archivo central 
 

 
figura 14 

 
Para activar un workset: 
 

1. Abrir el proyecto que se requiere para activar las funciones del workset. (es el 
proyecto que se convertirá en el archivo central). 

2. Escoger pestaña Collaborate => Panel Worksets =>  (Worksets) 
3. Se despliega la caja de dialogo Worksets 
 

 
Figura 15 

 
Sí ya existen elementos creados en el proyecto, estos serán trasladados al workset 
que se define en la casilla Move remaining elements to workset. 
 

4. Presionar el botón Ok para salir del cuadro de dialogo 
5. Grabar el archivo con la opción Save As. 
6. En el cuadro de dialogo Guardar como, presionar el botón Options y verificar que 

la opción Make this a Central Model after save este activa 
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Figura 16 

 
Al grabar el archivo por primera vez después de definir un workset, el programa le 
indicara que será grabado con la característica de archivo central. 
 
El archivo central debe ser guardado en una ubicación compartida a la que pueden 
tener acceso todos los usuarios que son parte del grupo de trabajo. 

 
Para crear worksets: 

1. Escoger pestaña Collaborate => Panel Worksets =>  (Worksets) 
2. En el cuadro de dialogo Worksets presionar el botón New 
3. Definir el nombre del workset 

 

 
Figura 17 

 
4. Presionar el botón OK para salir del cuadro de dialogo de creación de worksets 
5. Grabar el proyecto nuevamente usando la opción Save As… 
6. En el cuadro de dialogo grabar archivos  hacer clic en el botón Options 
7. Asegurarse que la opción Make this a Central Model after save este activa 
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Figura 18 

 
Para definir los worksets como no editables: 

1. Escoger pestaña Collaborate => Panel Worksets =>  (Worksets) 
2. Bajo la columna Editable escoger la opción NO, para todos los worksets que serán 

entregados a los usuarios 
 

 
Figura 19 

 
3. Grabar nuevamente el archivo asegurándose que la opción Make this a Central 

Model after save este activada. 

4. Escoger la pestaña Collaborate => panel Synchronize => icono  
(Synchronize with Central). Esto asegura que los cambios realizados estan 
actualizados 
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Figura 20 

 
Para asignar instancias a un workset: 
 

1. Seleccionar los componentes que se requiere agregar a un workset 
2. En las propiedades de instancia 
3. Bajo el grupo de parámetros Identity Data, desplegar la casilla Workset 
4. Seleccionar el workset en el cual se quiere ubicar los objetos seleccionados 
 

 
Figura 21 

 
IMPORTANTE: antes de asignar los worksets a los usuarios que serán los propietarios, 
debe colocarlos en modo NO editable, esto permitirá que se elimine el usuario inicial con 
el que fueron creados y se pueda asignar un nuevo usuario. 
 
Para que un usuario tome un workset como propietario: 
 

1. Antes de que el usuario tome un workset es necesario que previamente defina el 
nombre de usuario que usara en Revit. 

2. Debe asegurarse que los worksets que van a ser tomados por los usuarios estén 
como NO editables en el archivo central 

3. Abrir el archivo central que debe encontrarse en una ubicación compartida 
4. Abrir el archivo que fue definido como archivo central. 
5. Ingresar al cuadro de dialogo worksets 
6. Seleccionar el workset y bajo la opción Editable escoger la opción “Yes” 
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Figura 22 

 
Automáticamente el usuario que está definido en el cuadro de dialogo Options, 
será asignado como propietario del workset. 
 

7. Salir del cuadro de dialogo de Worksets aceptando los cambios 
8. Sincronizar con el archivo central 

9. Escoger Menú de aplicaciones  => opción Close (para cerrar el archivo) 
10. En el cuadro de dialogo Editable Elements escoger opción Keep ownership of 

Elements and worksets 
 

 
Figura 23 

 
11. Esto creará una copia local del archivo, cuyo nombre está compuesto por el 

nombre del central_nombre de usuario.rvt 
 
Este es el archivo en el que debe trabajar el usuario. 

 
 
Para sincronizar los cambios realizados en el archivo local con el archivo central: 
 

1. Grabar usando la opción Save 
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2. Escoger pestaña Collaborate => Panel Zynchronize =>  icono 
Zynchronize with central 

 

 
Figura 24 

 
Para visualizar los cambios realizados en otros worksets: 

1. Escoger pestaña Collaborate => Panel Syncrhonize =>  (Reload Latest) 
 
 
Solicitar acceso a elementos de un workset 
 
Solo el propietario puede modificar los elementos de su workset. En caso de que otro 
usuario necesite acceso a los elementos de un workset del cual no es propietario, deberá 
enviar una solicitud al propietario al cual pertenece el elemento que requiere editar. 
 
Cuando el dueño de un workset recibe una solicitud de préstamo de objetos, este puede 
ceder o negar el acceso a los objetos. 
 
Para enviar una solicitud a un propietario de otro workset: 
 

1. Seleccionar el objeto y hacer clic sobre el icono “Make element editable” 
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Figura 25 

 
2. Se despliega un cuadro de dialogo indicando que el elemento no puede ser 

modificado debido a que pertenece a otro workset 
 

 
Figura 26 

 
3. Presionar el botón Place Request. Se muestra un cuadro de dialogo que indica 

que el requerimiento ha sido enviado al propietario del objeto 
 

 
Figura 27 

 
4. El propietario del workset al que pertenece el objeto recibirá una notificación. 
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Figura 28 

 
Para revisar los requerimientos para edición de objetos: 
 

1. Escoger pestaña Collaborate => panel Syncronize => icono  
2. Se muestra el cuadro de dialogo donde se indican todas las requisiciones 

pendientes de contestar: 
 

 Con fecha y hora en la cual fue enviada 

 Usuario que hacer la solicitud 

 El tipo de objeto y el ID 
 

 
Figura 29 
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3. Puede optar por  ceder los objetos que se están requiriendo, para esto presionar el 
botón Grant, o denegar el acceso presionando el botón Deny/Retract 

4. Los usuarios que han realizado la solicitud serán notificados. 
 
Para devolver un elemento prestado: 
 

1. Una vez que el objeto le ha sido prestado, realizar las modificaciones requeridas 
2. En el momento en que sincroniza con el proyecto central, en la caja de dialogo 

Syncronize with Central, la opción Borrowed Elements debe estar activada. 
 

Esto hará que el archivo central se actualice y devolverá los elementos prestados 
a sus respectivos worksets. 

 

 
Figura 30 

 
 
Ceder un workset (Relinquishing) 
 
Ceder o renunciar, significa que el propietario de un workset regresa los objetos al 
administrador del archivo central. 
 
Para renunciar a un workset: 

1. Escoger pestaña Collaborate => panel Syncronize => icono  (Relinquish All 
Mine) 
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Vistas y Documentación del proyecto 

 
El manejo de vistas es esencial para documentar toda la información relacionada con el 
proyecto. La documentación de un proyecto en Revit se genera con vistas de: Corte, 
detalles, fachada, leyendas, listados de cuantificación y materiales, vistas de llamada, 
vistas 3D, perspectivas y planos. Todos estos elementos que son guardados en vistas 
que contienen información específica del diseño principal, los cuales mantienen una 
sincronización en tiempo real en caso de que se realicen cambios. 
 
Las vistas de corte, fachada y detalles son 2D y estas se generan automáticamente a 
partir de la colocación de los símbolos de sección (section), elevación (Elevation) y 
llamada (callout) en una vista de planta, corte o fachada.  
 
 

Manejo de vistas 
 
La mayor parte de información del proyecto es guardada en vistas. Generalmente los 
cambios de propiedades realizados en una Vista no afectan a las demás. Pero si el 
modelo es cambiado en una vista en particular, los cambios serán visibles en todas las 
vistas del proyecto. Cada vez que una vista es generada está se listará en la ventana 
Project browser  desde la cual se puede navegar a través de todas las vistas del proyecto. 
 
Duplicado de vistas 
 
Las vistas pueden duplicarse usando tres métodos:  

 
Duplicado: genera una copia de la vista que no incluye anotaciones (cotas, etiquetas, 
textos, notas clave etc.). Las propiedades (escala, niveles de detalle, estilos visuales) de 
una vista generada con esta opción pueden cambiarse, sin que estos cambios se vean 
reflejados en la vista original. En este tipo de vistas se puede agregar anotaciones sin que 
estas se vean reflejadas en la vista original. Los cambios en la geometría del modelo 
afectan a todas las vistas del proyecto. 
 
Duplicado con detalle: genera una copia de la vista que incluye anotaciones (cotas, 
etiquetas, textos, notas clave etc.). Las propiedades (escala, niveles de detalle, estilos 
visuales) de una vista generada con esta opción pueden cambiarse, sin que estos 
cambios se vean reflejados en la vista original. En este tipo de vistas se puede agregar 
anotaciones sin que estas se vean reflejadas en la vista original. Los cambios en la 
geometría del modelo afectan a todas las vistas del proyecto 
 
Duplicado con dependencia: esta vista que comparte propiedades de parentesco con la 
vista principal, tales como escala de la vista, sombrados y anotaciones, por lo tanto es un 
duplicado exacto de la vista original. Cualquier cambio que se realice en este tipo de vista, 
ya sea relacionado con anotaciones, propiedades o geometría del modelo, se verán 
reflejados en la vista principal.  
 
Para crear duplicados de vistas: 
 

1. En el Project Browser, hacer clic derecho sobre la vista que se requiere duplicar. 
2. En el submenú escoger opción Duplicate 
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figura 31 

3.  Escoger una opción de duplicando 
4. Cambiar el nombre de la nueva vista, haciendo clic derecho sobre el nombre de la 

vista en el Project browser => en el submenú escoger opción Rename 
 

 
figura 32 

 
 
Vistas de Corte 
 
Las secciones o cortes se usan para ver la elevación del modelo a los largo de un plano 
vertical específico. Las secciones pueden ser cortadas en segmentos, además pueden 
crearse secciones de referencia para vistas existentes. 
 
En Revit una sección se representa con una “línea de sección”, la cual tiene asociada una 
vista llamada “Vista de sección”. 
 
Una sección genera un corte de los componentes interiores visibles del modelo a lo largo 
de la línea de sección.  
 
Para crear una Vista de corte: 
 

1. Activar la vista de planta correspondiente 

2. Escoger Pestaña View => Panel Create => icono  (Section) 
3. Dibujar la línea de corte, especificando un punto inicial y un punto final 
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figura 33 

 
4. Para activar la vista de corte, hacer doble clic sobre la etiqueta de referencia de la 

línea de sección o en el Project browser desplegar la sección Sections (Building 
Sections) 

 

 
figura 34 

 
Para ajustar una vista de corte: 
 

1. SE puede cambiar la dirección haciendo clic sobre la marca Flip Section 
 

 
figura 35 

 
2. Se puede cambiar profundidad y longitud que cubre la línea de corte, haciendo clic 

y arrastrando las guías  de la línea de corte 
 

 
figura 36 

 
 
Para cortar la línea de sección: 
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La línea de sección puede cortar, para eliminar la visualización de cierta parte de la vista.  
 

1. Seleccionar la línea de sección, hacer clic sobre el símbolo  . 
2. Una vez cortada la línea se puede seleccionar los nodos de los extremos para 

ajustar el área de corte 
 

 
figura 37 

 

3. Para eliminar el corte de la línea de sección hacer clic sobre el símbolo  
 
Para cambiar la dirección del  corte: 
 

1. Seleccionar la línea de sección  
2. Hacer clic sobre el símbolo flip Section 

 

 
figura 38 

 
 
Para dividir una línea de sección: 
 
La línea de sección puede dividirse para generar una trayectoria irregular. 
 

1. Seleccionar la línea de sección 

2. En la pestaña contextual Modify Views => panel sections => escoger icono   
(Split Segment). 

3. Hacer clic sobre la línea de sección, en el sitio a dividir 
 

 
figura 39 

 
4. Arrastrar el puntero en una dirección 
5. Hacer clic en el sitio donde colocará el segmento dividido 
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figura 40 

 
Cambiar el símbolo de la línea de corte: 
 

1. Puede explorar las familias de símbolos de sección que trae Revit, las cuales se 
encuentran en la carpeta US Metric/Annotations y cargarlas al proyecto 

  
figura 41 

 
Los archivos de familia cuyo nombre comienza con M_Setion Head* son los que 
tienen la geometría del símbolo de la sección, que es donde se muestra la 
información de la vista (una vez que ha sido colocada en un plano) 

 

  
 

Los archivos de familia cuyo nombre comienza con M_Section Tail* son los que 
tienen la geometría del símbolo que aparece en el otro extremo de la línea de 
sección. 
 

 
2. Para cambiar el símbolo de la sección, se selecciona la lína de sección 
3. En la paleta de Propiedades, en la propiedades de tipo, bajo de grupo de 

parámetros Graphics, hacer clic sobre la casilla que esta frente a la opción Section 
Tag 
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figura 42 

 
4. Se despliega la caja de dialogo  de propiedades de tipo donde se muestran los 

parámetros que permiten cambiar el símbolo tanto el que va a la cabeza de la 
línea de sección como al otro extremo. 

 

 
figura 43 

 
 
Vistas de Elevación 
 
Las vistas de elevación son parte de la plantilla de los proyectos, y facilitan la 
visualización del modelo desde una dirección específica. Las vistas de elevación por 
defecto que se crean en un proyecto son: north, south, east, y west. 
 
Las vistas de Elevación muestran una vista horizontal del diseño desde cierto punto. Las 
vistas de elevación muestran niveles, puertas, ventanas y todos los componentes  del 
diseño.  
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figura 44 

 
Para crear una vista de elevación: 
 

1. Activar la vista de planta correspondiente 

2. Escoger pestaña View => Panel Create => icono  
3. Definir la ubicación del símbolo de referencia de la elevación 

 

 
figura 45 

 
4. Generalmente el símbolo de referencia de elevación suele asociarse con la 

dirección de los muros o ejes. Al seleccionar el símbolo de elevación, se observa 

que se puede girar usando la opción  , y la dirección que muestra activado un 

visto  es la dirección actual hacia donde apunta la elevación. 
 

 
figura 46 

 
5. También se puede cambiar la profundidad y longitud de la elevación, 

seleccionando la flecha del símbolo de elevación, se activarán las guías que se 
encuentran a los extremos.  

 

http://www.darco.com.mx/


 

33 

DERECHOS RESERVADOS DARCO S.A. DE C.V.  2015 
www.darco.com.mx  

 

 
figura 47 

 
6. Para activar la vista de fachada, hacer doble clic sobre la flecha del símbolo de 

elevación. 
7. Las vistas se elevación se generan bajo la sección Elevations en el Project 

Browser 
 

 
 
figura 48 

 
Para crear más de una vista de elevación a partir de un símbolo de elevación: 
 

1. Seleccionar el símbolo de elevación 
 

 
figura 49 

 
2. Se despliegan en los cuadrantes del símbolo unos recuadros. Los recuadros que 

están vacíos indican que no tienen una vista de elevación creada en esa dirección 
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figura 50 

 
3. Activar el recuadro del lado en el cual necesite crear la vista de elevación 

 

 
figura 51 

 
Cuando la nueva vista de elevación es creada, se mostrará un nuevo símbolo que 
indique que hay una vista de elevación que apunta en esa dirección. 
 

Para cambiar el simbolo de elevación: 

1. Escoger pestaña Insert => panel Load from Library => escoger icono  
(Load Family) 

2. En la carpeta Annotations  escoger en el listado de archivos cualquiera de la 
familias de simbolos de elevación. 

 

 

3. Escoger Pestaña Manage => Panel Settings => icono  (additional 

Settings) =>  
4. En la caja de dialogo de propiedades de tipo, desplegar la casilla Elevation 

Mark y seleccionar el simbolo a usar 
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figura 52 

 
 
 

 
Referencias a Vistas 
 
Una referencia es un símbolo que indica el número de vista y número de plano al cual 
esta referenciada la vista. Las referencias a vistas pueden ser colocadas en cualquier 
vista estándar, excepto listados de cuantificación, planos y perspectivas. En las vistas 3D 
bloqueadas se pueden colocar referencias también. 
 
Los símbolos de referencia se crean o editan como el editor de familias y pueden contener 
líneas, regiones de relleno, textos, etiquetas y además contienen los parámetros que 
indican las referencias a vistas. 
 
NOTA: tomar en cuenta que para trabajar con referencias a vistas, las vistas a la cual 
hacen referencias deben estar colocadas en un plano. Por ejemplo; si crea una vista de  
detalle de un mueble a partir de una vista de planta; la vista de planta debe existir en una 
vista de plano, porque de lo contrario el símbolo de la referencia no mostrará ningún valor. 
 
Una referencia puede vincularse con más de una vista. Por ejemplo; En la imagen, el 
detalle del área donde está la lámpara puede vincularse con la vista de planta o con la 
vista de sección. 
 

 
figura 53 

 
Para colocar una referencia a vista: 
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1. Crear o abrir la vista en la cual se va a colocar la referencia 

2. Escoger pestaña View => panel Sheet Composition => icono  (View Reference) 
3. Escoger la pestaña contextual Modify View Rerefence  => panel View Reference 

desplegar las casillas  
 
View Type: para definir con que tipo de vista estará vinculada la referencia, que 
puede ser, vista de planta, corte, elevación etc. 
Target View: para definir el nombre de vista con la cual estará vinculada la 
referencia. 

 

 
figura 54 

 
4. Hacer clic en el sitio donde quedará colocada la referencia 

 

 
figura 55 

 
 

Vistas de Detalle (Callouts) 
  
Cuando se crea un detalle directamente en el modelo se está utilizando la geometría real 
de Revit y se está aprovechando de las ventajas y capacidades paramétricas de Revit.  
Usar este método le permite maximizar la utilidad del modelo 3D  
 
Para crear un detalle en el modelo, se debe primero crear una vista callout en una vista en 
planta, alzado (Elevation) o corte (Sección), al hacer esto se puede entonces retomar 
elementos existentes así como agregar nuevos componentes de detalle en la vista callout. 
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Un vista callout selecciona un área de una planta o de una elevación y magnifica esa 
área.  Se pueden poner vistas callout en los planos y serán numeradas automáticamente. 
Las vistas callout  se comportan como cualquier otra vista en Revit.  A una vista callout se 
le puede continuar agregando componentes de modelo y símbolos de anotación a dicha 
vista.   
 
Para crear una vista callout: 

1. Escoger la pestaña View => Create =>desplegar icono   => opción 

 
2. señalar le región que quiere representarse, esa operación se puede realizar en las 

vistas de planta, corte o alzado. Cada vez que se cree una vista callout se genera 
una marca de referencia en la vista en que fue generada así como su 
correspondiente vista en el Project browser 

 

 
 
figura 56 

 
3. Para abrir la vista de detalle, hacer doble clic sobre el símbolo de referencia. 

 
 
Propiedades de una vista 
 
Las propiedades de una vista permiten controlar y modificar las siguientes funciones: 
 
Escala: permite ver la escala de la vista tal y como aparece en la hoja de dibujo. Para 
cambiar la escala de una vista, seleccione un valor de la escala de la lista. 
 
Para ver y cambiar el valor de escala de una vista: 
 

1. En la barra de herramientas de control escoger icono escala o también en la 
ventana de propiedades desplegar la casilla View Scale 
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figura 57 

  
En caso que la escala a configurar no esté en el listado, escoger la opción 
Custom.  

 
Niveles de detalle: Aplica un nivel de detalle de ajuste a la escala de la vista: básico, 
medio, o fino. Este ajuste anula el ajuste automático de nivel de detalle para la vista.  
 
Cuando se aplica un nivel de detalle a una vista, se permite la visibilidad de determinadas 
formas de la geometría:  
 

 La estructura compuesta de muros, pisos, techos, en el nivel de detalle medio y 
fino.  

 Cambios en la familia dependiendo de la geometría de los niveles de detalle. 
  

 Los cambios estructurales dependiendo del nivel de detalle. En el nivel básico, 
aparece como líneas. En los niveles medio y fino, se muestra con más de 
geometría.  
 

     
Básico    Medio    Fino 
 
figura 58 

        
 
Para cambiar un nivel de detalle: 
 

1. En la barra de herramientas de control, hacer clic sobre el icono Detail Level 
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figura 59 

 
2. Escoger la opción, según el nivel de detalle a usar. 

 
Detalles repetitivos 
 
Con la herramienta Detalle de repetición, se define un recorrido marcando el punto inicial 
y final, el recorrido designado coloca como un patrón de relleno (hatch)  el componente de 
detalle seleccionado en las propiedades de tipo.  
 
Para colocar un detalle repetitivo: 
 

1. Cargar la familia de componentes de detalle que se requiere usar como un detalle 
repetitivo 

2. Escoger pestaña Annonate => panel Detail => desplegar icono  

(Component) => escoger opción  
3. En la paleta de propiedades, en las propiedades de tipo desplegar la casilla Detail  
4. Seleccionar el detalle que  se va a repetir 

 

 
figura 60 

 
5. Desplegar la casilla Layout y escoger el formato para la colocación del detalle, que 

puede ser: Espaciado fijo, número de elementos, Máximo espaciado, llenar con 
espacio disponible 
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figura 61 

 
6. En la casilla Spacing, escribir el valor del espaciado o el número de elementos, 

según sea el caso 
7. Definir el punto inicial y luego el punto final  

 

 
figura 62 

 
 
Para asignar estilos de línea a las capas de elementos compuestos: 
 

1. Activar la vista de detalle correspondiente 
2. Activar el cuadro de dialogo Visibility Graphics  
3. En la sección Override Host Layers, activar la opción Cut Line Styles 

 

 
figura 63 

 
4. Presionar el botón Edit 
5. En el cuadro de dialogo Host Layer Line Styles, asignar grosor, color y patrón de 

línea. 
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figura 64 

 
Bajo la columna función se muestran las capas de que forman la estructura de; 
muros, techos, pisos, cubiertas y losas. 

 
6. Aceptar todos los cambios. 

 
Para asignar colores  a  otros componentes: 
 

1. Activar la vista de detalle correspondiente 
2. Activar el cuadro de dialogo Visibility Graphics 
3. En la pestaña Model Category desplegar la categoría a la cual se requiere 

cambian el estilo de línea 
4. Seleccionar el elemento de la categoría para cambiar el estilo y bajo la columna 

Projection/Surface, hacer clic en la opción Override 
 

 
figura 65 

 
5. En la caja de dialogo Line Graphics seleccionar las características para el estilo de 

línea 
 

 
figura 66 

 
6. Aceptar los cambios y salir del cuadro de dialogo Visibility Graphics 
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figura 67 

 

Drafting View 
  
Las vistas Drafting se utilizan para dibujar elementos o detalles adicionales que no son 
parte del modelo, estas vistas solo servirán referencia y no estarán ligadas al proyecto. En 
este tipo de vistas sólo podrá usar las herramientas de detalle y líneas modelo para 
dibujar. 
 
Para crear una vista Drafting: 

1. Escoger Pestaña View => Panel Create =>  
 

Vistas de leyenda 
 
Las vistas de leyenda permiten crear leyendas donde se listan los componentes del 
edificio y anotaciones que se utilizan en el proyecto. 
 
Para crear una vista de leyenda: 
 

1. Escoger Pestaña View => Panel Create => desplegar icono  => opción 

 (Legend) 
2. En la caja de dialogo nueva vista de leyenda, definir la escala y nombre de la vista 

 

 
figura 68 

 
Para agregar componentes de anotación a una vista de leyenda: 

http://www.darco.com.mx/


 

43 

DERECHOS RESERVADOS DARCO S.A. DE C.V.  2015 
www.darco.com.mx  

 

1. Escoger pestaña Annotate => panel Detail =< desplegar icono  

(Component) => opción  (Legend Component) 
2. En la barra de herramientas de opciones desplegar la casilla Family para escoger 

la familia y tipo a representar en la leyenda 
 

 
figura 69 

 
3. En la barra de herramientas de opciones desplegar la casilla View y escoger el tipo 

de vista a usar para representar el elemento 
 

  
figura 70 

 
4. Para completar la leyenda puede colocar notas clave con las descripciones de los 

elementos 
 

 
figura 71 
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Control de visibilidad de gráficos 
 
Visibility Graphics (visibilidad de gráficos) 
 
Revit puede también controlar la visibilidad de categorías de los elementos por vista, 
usando el comando de Visibility/Graphics.  En un diseño complejo, el comando permite 
simplificar  una vista exhibiendo solamente los componentes necesarios.   
 

 
figura 72 

 
Para activar la caja de dialogo Visibility Graphics: 
 

1. Escoger pestaña View => Panel Graphics =>  
2. Para desactivar la visualización de una o varias categorías de objetos en una vista 

hacer clic sobre la palomita que se encuentra al lado izquierdo de la categoría. 
 

    
 
Categoría visible  Categoría no visible 
 

En la caja de dialogo Visibility Graphics existen varias pestañas que permiten controlar la 
visibilidad de las categorías según el tipo que corresponda.  
Las pestañas Model Categories y Annotation Categories, permiten activar o desactivar la 
visibilidad de las categorías modelo y de Anotación respectivamente. 
 
La pestaña Imported Categories: activa o desactiva la visibilidad de los archivos que 
hayan sido importados o vinculados al proyecto actual (DWG, RVT, DGN, DWF, etc.) 
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La pestaña Filters: permite agrupar categorías bajo un nombre. 
 
Filtros 
 
Los filtros son una herramienta que le permite controlar la visibilidad de un grupo de 
elementos que pertenecen a diferentes categorías, pero que comparten propiedades en 
común. 
 
Para crear un filtro: 
 

1. Entrar al cuadro de dialogo Visibility Graphics y activar la pestaña Filters 
2. Presionar el botón Add 
3. Presionar el botón Edit/New… 

4. En la caja de dialogo Filters, bajo la columna Filters, presionar el botón  para 
crear un nombre para el filtro 

 

 
figura 73 

 
 

5. Bajo la sección Cateogories, seleccionar las categorías a incluir en el grupo de 
elementos 
 

 
figura 74 
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6. En la sección Filter Rules, definir las reglas que utilizará para incluir los elementos  

 

 
figura 75 

 
Al definir la regla o reglas para un filtro, se está condicionando a que sólo los 
objetos que cumplen con esa regla entraran en el filtro. Por ejemplo; para crear un 
filtro en el cual solo queden incluidas las puertas que son de tipo 1.00 m x 2.40 
Madera. Aunque  en las categorías haya sido seleccionada la categoría puertas, el 
filtro solo incluirá las puertas que cumplen con la condición del ser del tipo 1.00 m x 
2.40 Madera. 

 
7. Presionar el botón OK para salir del cuadro de dialogo y luego seleccionar el filtro 

que ya debe mostrarse en el listado de filtros 
 

 
figura 76 

 
8. Presionar el botón Ok 
9. Se despliega el filtro en la caja de dialogo Visibility Graphics. Puede cambiar las 

propiedades de color, grosor y tipo de línea de los objetos que son parte del filtro y 
controlar la visibilidad. 
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figura 77 

 
 
Asignación de  propiedades a las categorías 
 
Por defecto la mayoría de categorías en Revit están definidas de color negro, sin embargo 
se puede personalizar el color de la categoría, ya sea por cada vista o todas las vistas. 
Esto se hace desde el cuadro de dialogo Visibility Graphics 
 
Para asignar propiedades a categorías en todas las vistas del proyecto: 
 

1. Escoger pestaña View => panel Graphics => icono  ó, teclear 
VG 

2. Activar la pestaña Model Categories, presionar el botón  
3. Seleccionar la categoría que se requiere cambiar  
4. Cambiar el color, grosor y patrón de línea, dependiendo de los estandares a 

manejar 
 

 

 
figura 78 
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Para asignar propiedades a las categorías por vista: 
 

1. Colocar activa la vista en la cual se requiere cambiar las propiedades de los 
objetos por categoría 

2. Escoger pestaña View => panel Graphics => icono  ó, teclear 
VG 

3. Activar la pestaña Model Categories 
4. Seleccionar la categoria a cambiar en el listado de la columna Visibility. 

 

 
figura 79 

 
5. Realizar los cambios en colores, grosores, rellenos y patrones de línea. 

 
 

Vistas 3D 
 
Se pueden crear vistas 3D desde las vistas de planta, elevación o sección. Existen dos 
tipos de vista 3D; Vista 3D paralelas y Vista de Cámara. 
 

 
figura 80 

 
Cuando una vista 3D paralela o de cámara está activa, se muestran las opciones de 
navegación 3D, en la parte superior derecha de la vista.  
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El ViewCube permite la visualización del diseño 3D desde diferentes puntos vista; 
frontales, laterales e isométricas. 
 

 
figura 81 

 
Puede hacer clic sobre los vértices o caras del cubo, para combinar ángulos de 
visualización en vistas isométricas 
 

     
figura 82 

 
La herramienta Full Wheel Navigation, complementa las opciones para girar, realizar 
zoom, encuadre, y restituir las vistas anteriores a la actual (rewind) sobre las Vistas 
Default 3D.    
 

 
figura 83 

 
Vista 3D paralelas 
 
Son las vistas 3D por defecto, la visualización de estas vistas se controla a través del 
View Cube, y muestran todos los elementos de la vista a la misma distancia y tamaño. 
 
 
Para crear una vista 3D: 

1. Escoger Pestaña View => Panel Create =>  
2. Para usar las opciones del View Cube, hacer clic sobre cualquiera de las caras del 

cubo 
 

 
figura 84 

 
3. En la rueda del View Cube, puede arrastrarse de forma interactiva para girar la vista 
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figura 85 

 
4. Para hacer Zoom, Encuadre y Orbita en tiempo real, activar el comando Full 

Navigation Wheel, desde la barra de herramientas de navegación 
  

 
figura 86 

 
Para cambiar el nombre de una vista 3D: 
 

1. Seleccionar la vista llamada 3D View, que está bajo la opción 3D View en el 
Project browser 

2. Hacer clic con el botón derecho sobre el nombre  
3. Escoger opción renombrar 

Escribir el nuevo nombre 
 

Para recortar vistas 3D: 
 

1. Activar la vista 3D 
2. En la paleta de propiedades en las propiedades de instancia, bajo el grupo de 

parámetros Extents activar la casilla que esta frente a la opción Section Box 
 

 
figura 87 

 
3. Se observa que se crea un cubo alrededor de los elementos que son visibles en la 

vista. Seleccionar el cubo. Cada cara del cubo muestra unas guías que al 
arrastrarlas en una dirección específica recortan la vista. 
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figura 88 

 
 

Vistas de Cámara 
 
Las vistas de  cámara permiten generar perspectivas del modelo 3D. 
 
Para crear una vista de cámara: 
 

1. Activar una vista de planta 

2. Escoger pestaña View => panel Create => Desplegar icono  3D View => 

opción  
3. En la barra de herramientas de opciones en la casilla Offset escribir la altura de la 

cámara y el nivel al cual estará referenciada. 
 

 
figura 89 

 
4. Definir en la vista donde se va a colocar la cámara 
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figura 90 

 
5. Determinar hacia donde apunta el objetivo de la cámara y hacer clic en el sitio 

hacia donde apunta el objetivo 
 

 
figura 91 

 
6. La vista de perspectiva se abrirá automáticamente. Puede ajustar el área de 

visibilidad desplazando los nodos que se encuentran a cada lado del recuadro que 
indica el área de visualización de la vista. 

 
 

http://www.darco.com.mx/


 

53 

DERECHOS RESERVADOS DARCO S.A. DE C.V.  2015 
www.darco.com.mx  

 

 
figura 92 

 
7. Las vistas de cámara se colocan en el navegador de proyectos bajo la sección 3D 

Views, por defecto se nombran como 3D View. 
 

 
 
Para modificar altura de la cámara y objetivo: 
 

1. Activar la vista de perspectiva 
2. En la paleta de propiedades, en las propiedades de instancia bajo el grupo de 

parámetros Camera están las opciones que permiten modificar, tanto la altura de 
la cámara como del objetivo 

 

 
figura 93 

 
 
Despiece de vistas 3D 
 
Permite crear conjuntos de despiece del proyecto. 
 
Para crear un conjunto de despiece: 
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1. Activar una vista 3D 
2. Seleccionar cualquier elemento de la vista  

3. En la pestaña contextual Modify Roofs => panel View => escoger icono  
(Displace Elements) 

4. Se activa entonces el panel Displacement Set 
 

 
figura 94 

 
Para agregar más elementos al conjunto de despiece: 
 

1. En el panel Displacement Set => escoger icono (Edit) 

2. En la barra de herramientas Edit Displacement Set, activar icono  (Add) 
3. Seleccionar los elementos adicionales que serán parte del despiece 

 

 
figura 95 

 

4. Presionar el botón  (Finish) para terminar la selección 
5. Utiilizando el Gizmo que se muestra sobre el conjunto de selección de despiece, 

desplazar los elementos en la dirección requerida 
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figura 96 

 
Crear un path de despiece: 
 
El parth de despiece, permite mantener vinculado un elemento a otro a través de líneas 
que facilitan la visibilidad y dirección de los objetos en el ensamblaje. 
 

1. Generar un despiece sobre uno o varios objetos 
 

 
figura 97 

2. En el panel Displacement Set => escoger icono  (Path) 
3. Hacer clic sobre el punto que se corresponde para la conexión con otros 

elementos. 
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figura 98 

 
 
 
 
Plantillas de Vistas  
 
Las plantillas de vista sirven para estandarizar las vistas de proyecto. Revit tiene algunas 
plantillas predefinidas, las cuales puede usar el usuario como base para crear las suyas 
propias. 
 
Para crear una plantilla de vista: 

1. Escoger pestaña View => panel Graphics => desplegar icono  (View 

Templates) => opción  
2. En el listado de plantillas escoger la plantilla de vista a usar como base 

3. Hacer clic sobre el botón  (Duplicar) 
4. Asignar el nombre a la plantilla 
5. En la casilla Filtros de disciplina y filtros de tipos de vista, escoger la disciplina  y 

tipo de vista a usar como base 
6. En la sección View properties  escoger escala de vista y nivel de detalle 

 

 
figura 99 
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7. Hacer clic sobre el botón Edit que esta frente a la opción V/G Overrides Model 
8. Definir los colores y grosores de línea para  cada categoría que se requiera 

manejar. 
 

 
figura 100 

 
9. Nuevamente en la sección View properties de la caja de dialogo View Templates, 

definir el resto de configuraciones que se necesiten.  
 

 
figura 101 

 
10. Presionar el botón OK, para salir y aceptar los cambios. 

 
Para aplicar una plantilla de vista: 
 

1. Activar la vista a la cual se quiere aplicar la plantilla 

2. Escoger pestaña View => panel Graphics => desplegar icono  =>  opción 

 
3. En la caja de dialogo Apply View Template escoger la plantilla a aplicar 
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figura 102 

 
4. Presionar el botón OK para salir. 
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Listados de Cuantificación y Materiales 

 
Las tablas son consideradas como un tipo de vista en Revit, las tablas despliegan 
información que se extrae del proyecto, esta información es contenida en las propiedades 
de cada componente. 
 
La información que se despliega en las tablas es mostrada en forma de lista, pero se 
pueden generar criterios de despliegue lo que dará mayor versatilidad a las tablas, así por 
ejemplo podemos tener agrupados los elementos por piso, por tipo, por cuarto etc. 
 
Inmediatamente después que es creada una tabla, aparece su vista en pantalla, pero 
además, la vista es salvada en la lista del Project browser. 
 
Las tablas pueden crearse en cualquier momento del proceso de diseño del proyecto, y 
los cambios que este sufra se verán reflejados inmediatamente. Las tablas pueden 
agregarse a un plano. 
 
Al momento de aceptar los parámetros de la tabla, se desplegará un listado, en el que se 
debe escoger los campos a contabilizar (anchos, alturas, materiales, costos, nombres, 
familias etc.) los criterios de despliegue (si los objetos de despliegan por cuarto, por nivel 
por marca, por familia etc.), organización, así como el aspecto de tabla (tipo de texto, 
altura de campos etc.) 
 
Los listados ser exportados como archivos de texto o a una tabla de base de datos. 
 
Los tipos de listado que genera Revit son: 
 

 Listados de materiales: desglosan la  estructura de elementos complejos tales 
como; muros, pisos, techos, losas etc. Estas tablas se llaman Material Takeoff 

 Listados de cuantificación: cuantifican componentes del modelo tales como 
puertas, ventanas, mobiliario, etc. 

 Listados de planos: genera un listado de planos 
 
Los parámetros a configurarse  cuando se crear un listado son: 
 
Fields (Campos) 
 
En esta sección aparecerán todos los campos disponibles de acuerdo a la categoría 
seleccionada, es importante mencionar que en el orden en que se selecciones los 
campos, será el orden de despliegue final.  
 
Filter (Filtros) 
 
Permite crear filtros que limitan el despliegue de los datos en el listado, por ejemplo se 
puede limitar el listado para que  muestre la información de las puertas de un solo nivel. 
 
Sorting/Grouping 
 

http://www.darco.com.mx/


 

60 

DERECHOS RESERVADOS DARCO S.A. DE C.V.  2015 
www.darco.com.mx  

 

Permite ordenar el listado agrupando de forma ascendente o descendente las filas de 
acuerdo a un criterio (campo). También incluye funciones que agrupan los datos 
colocándoles encabezados, títulos, y totales 
 
Formatting 
 
Define el formato para los encabezados del listado, de los campos y activa la función de 
mostrar totales para los campos numéricos. 
 
La función de formato condicional permite crear un filtro de identificará de un color 
diferente aquellas celdas del listado que cumplan con una condición establecida. 
 
Appearance 
 
Establece la apariencia del listado en cuanto se refiere a estilos de texto y formatos de la 
tabla. 
 
Para crear un listado de cuantificación: 
 

1. Escoger pestaña View => Panel Create => Desplegar icono  => 

opción  
2. En la sección Category, escoger en el listado la categoría de la cual se va a 

generar el listado y asignar un nombre  
 

 
figura 103 

 
3. En la pestaña Fields, seleccionar los campos que se incluirán en el listado y hacer 

clic en la opción Add 
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figura 104 

 
4. Activar la pestaña Filter. Opcionalmente podrá definir un filtro para limitar los datos 

que se mostrarán en el listado 
 

 
figura 105 

 
5. Activar la pestaña Sorting/ Grouping. Definir el campo que se usará para organizar 

el listado. Activar las opciones Header and Footer para colocar títulos, cantidades 
y totales al final de cada grupo. 

 
Activar la opción Grand Totals, cuando se requiera totales generales de los 
campos numéricos. 
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figura 106 

 
6. Activar la pestaña Formating, para establecer los nombres y justificación de 

encabezados. 
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figura 107 

 
7. Presionar el botón Field format, para establecer el formato de los campos, y activar 

la opción Calcule totals, para calcular totales en los campos numéricos. 
 

 
figura 108 

 
8. Presionar el botón Aceptar para generar el listado 
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figura 109 

 
Para crear un listado de materiales: 

1. Escoger la pestaña View => Create => Schedule =>  
2. Escoger la categoría o categorías de elementos sobre los cuales se va a generar 

el listado. 
3. En la pestaña Fields escoger los campos a incluir en el listado 

 

 
figura 110 
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Los campos que desglosan los materiales de un elemento compuesto, comienzan 
con el nombre Material: 

4. Opcionalmente definir filtros en la pestaña Filter 
5. Organizar el listado  configurando las opciones den la pestaña Sorting/Grouping 
6. Establecer  nombres de encabezados y formatos 
7. Generar listado 

 

 
figura 111 

 
NOTA: Desde la versión 2105 de Revit en los listados de materiales de muros se puede 
incluir nivel base y nivel superior. 

 
Para editar un listado: 
 

1. Activar la vista del listado 
2. En las propiedades de Instancia, bajo los parámetros llamados Others, hacer clic 

sobre el botón Edit, que este frente a cualquiera de las opciones de configuración 
del listado. 

 

 
figura 112 

 
3. Se desplegara la caja de dialogo de propiedades del listado 

 
Para crear un formato condicional: 
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1. Entrar a las propiedades del listado, y activar la pestaña Formating 
2. Seleccionar el campo que mostrará un color diferente en el listado 
3. Hacer clic sobre el botón Conditional Format 

 

 
figura 113 

 
4. Establecer la condición para el campo y el color que tomará la celda que cumpla 

con la condición. 
 

 
figura 114 

 
5. Aceptar  los cambios y salir del modo de edición 

 

 
figura 115 

 
Agregar imágenes a los listados de cuantificaciones y materiales: 
 

1. Crear o editar un listado de cuantificación o materiales 
2. En la pestaña Fields en el listado de campos disponibles buscar la opción “Image” 
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figura 116 

 
3. Seleccionar los campos adicionales que quiera incluir en el listado. 
4. Una vez generado el listado de cuantificación o materiales, bajo la Columna 

Imagen hacer clic sobre la casilla donde se quiere agregar la imagen 
 

 
figura 117 

 
5. Buscar la imagen a seleccionar, o presionar el botón Add para añadir una imagen 
6. Seleccionar la imagen a utilizar en el listado 

 
El listado de cuantificación no despliega la imagen, solo la ruta de donde se ha 
cargado 
 

 
figura 118 

 
7. Para visualizar las imágenes de un listado de cuantificación, debe colocar la vista 

en un plano 
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figura 119 

 
 

Para crear listados de planos: 

1. Escoger la pestaña View => Create => Schedule => opción  
2. Seguir el procedimiento ya indicado para crear la tabla 

 
 
Modificar formatos de tablas de listados 
 
Existen varias modificaciones o propiedades que se pueden agregar a las tablas de 
cuantificación o materiales, a continuación se describirán algunas de ellas: 
 
Para insertar filas: 
 

1. Para insertar una nueva fila de celdas en el área de los encabezados 

2. En el panel Rows => desplegar icono  (Insert) 
3. Escoger la opción correspondiente, dependiendo del lugar donde se quiera insertar 

la fila 
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figura 120 

 
Para fusionar celdas: 

 
4. Seleccionar las celdas que se requieren fusionar 

5. En el panel Titles & Headers => escoger icono  (Merge Unmerge) 
 

 
figura 121 

 
Para asignar colores a celdas: 
 

1. Seleccionar la celda o celdas 

2. En el panel Appearance => escoger icono  (Shading) 
3. En la paleta de colores, escoger los colores a asignar 
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figura 122 

 
 
Para insertar una imagen: 
 

1. Seleccionar la celda donde se colocará la imagen 
2. En el panel Titles & Headers => escoger icono Insert Image 
3. Seleccionar la imagen a cargar y escoger botón Abrir 

 

 
figura 123 

 
Formulas en listados 
 
En los listados de cuantificación y materiales se puede incluir columnas que contenga 
fórmulas. A través de estas fórmulas se podrá calcular valores que completen la 
información relacionada con precios de volúmenes, áreas etc. 
 
Para crear una columna que contenga una fórmula: 
 

1. En la caja de dialogo “Schedule Properties” activar la pestaña Fields 

2. Escoger presionar el botón  
3. En la caja de dialogo Calcular valores, en la casilla Name, escribir el nombre de la 

columna como va a aparecer en la tabla de cuantificaciones. 
4. En la opción Type, desplegar la casilla y escoger el valor, según el dato a calcular. 

En la figura, se observar que el valor seleccionado en Volume, porque el dato que 
se quiere obtener es el calculo de costo por volumen. 
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5. En la casilla Formula definir la fórmula según lo que vaya a calcular.  
 

 
figura 124 
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Dimensiones 

 
Las dimensiones son los elementos de vista que muestran tamaños y distancias en un 
proyecto. Hay dos tipos de dimensiones: temporal y permanente. Revit pone dimensiones 
temporales mientras se colocan los componentes en el proyecto.  Las dimensiones 
permanentes son utilizadas para definir un tamaño o una distancia particular. Cualquiera 
de los dos tipos de dimensiones se puede modificar y el componente al que son referidas 
es actualizado por consiguiente. 
 

Dimensiones Temporales 
 
Las cotas temporales se activan cada vez que una instancia es seleccionada, al quitar la 
selección, las costas temporales desaparecen. Las cotas temporales están ligadas 
directamente a los muros más cercanos al objeto seleccionado, en el caso de puertas y 
ventanas se pueden configurar las cotas temporales para que se muestren ligadas al 
centro o ancho de puertas y ventanas. 
 

 
figura 125 

 
Las cotas temporales pueden convertirse en cotas permanentes de tal forma que se 
pueda establecer restricciones sobre los objetos con las cuales están relacionadas. 
 
Para configurar la justificación de las cotas temporales sobre muros: 

1. Escoger pestaña Manage=> panel Settings => desplegar icono  => opción 

 
2. En la caja de dialogo de propiedades de dimensiones temporales en la sección 

Walls escoger el tipo de justificación sobre los muros 
3. En la sección Doors and Windows  escoger la justificación sobre puertas  y 

ventanas 
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figura 126 

 
Para convertir una cota temporal en permanente: 
 

1. Seleccionar un objeto 
2. Al activarse la cota temporal, hacer clic sobre el símbolo que se despliega bajo el 

valor de la cota temporal 

 
figura 127 

 
Para crear una restricción sobre una cota: 
 

1. Seleccionar la cota 

2. Hacer clic sobre el símbolo de candado  que se muestra por debajo de la cota  
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figura 128 

 

3. Cuando el símbolo de candado se ve cerrado  significa que la restricción está 
establecida. 

 
Para cambiar la línea de referencia de una cota temporal sobre un objeto: 
 

1. Seleccionar el objeto 
2. Cuando se muestra la cota temporal, ubicar el cursor sobre el nodo de la línea de 

referencia  que se quiere cambiar en la cota 
 

 
figura 129 

 
3. Arrastrar el cursor sobre la nueva referencia en el objeto y hacer clic sobre el 

objeto, entonces la cota temporal cambiará los valores correspondientes. 
 

  
figura 130 
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Dimensiones permanentes 
 
Una dimensión permanente es una dimensión que se fija en un lugar específico por el 
usuario. La dimensión es creada cuando se selecciona el icono azul de dimensionamiento 
que aparece al seleccionar un componente o al crear la dimensión con el comando de 
dimensionamiento. Las dimensiones permanentes pueden aparecer de dos formas: 
modificable y no modificable. 
 
Una dimensión permanente se considera modificable cuando la geometría a la que se 
refiere se selecciona para su modificación. Cuando esto ocurre el texto que aparece está 
listo para modificarse.   
 
Una dimensión se considera no modificable, cuando esta ha sido creada con los 
comandos de dimensionamiento, aunque la dimensión sea no modificable esta mantiene 
su relación con el componente al que es referenciado, esto es sí, el componente se 
modifica la cota se actualizara de manera automática 
 
Para crear dimensiones permanentes: 
 

1. Escoger la pestaña Annotate =>Panel Dimension 
 

 
figura 131 

  
Las opciones para dibujo de cota son: Alineada, lineal, angular, radial, punto de 
elevación, punto de coordenada y punto de ángulo. 

 
 Cotas alineadas (Acotando muros) 
 
Cuando se coloca una dimensión permanente en un muro se puede especificar, la 
justificación  de la cota, las intersecciones con otros muros, además de huecos dejados 
por puertas, ventanas y huecos de muro. 
 
Para crear cotas sobre muros: 

1. Escoger pestaña Annotate => Panel Dimension => icono  (Aligned) 
2. En la barra de herramientas de opciones especificar:  Justificación, Pick, y 

opciones de cota. 
 

 
figura 132 

 
En la casilla Place Dimensions: seleccionar la justificación de la línea de cota sobre 
el muro (por ejemplo al centro, o caras del muro) 
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En la casilla Pick: seleccionar Entire Wall, para acotar el muro completo 
 

3. Presionar el botón Options 
 

 
figura 133 

 
Cuando se activa la opción Openings; se agregarán líneas de cota sobre los 
huecos del muro (incluye huecos dejados por puertas y ventanas). La opción 
Centers, genera la línea de cota, hacia el centro del hueco, y la opción widths 
genera líneas de cota sobre el ancho del hueco. 
 

 
figura 134 

 
La opción Intersecting Walls; genera cotas sobre las intersecciones del muro. 

 

 
figura 135 

 
 La opción Intersecting Grids; agrega líneas de cota sobre ejes 
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 figura 136 

 
4. Escoger las opciones de cota requeridas y presionar el botón OK 

 
Para crear tipos de cotas: 
 

1. Ejecutar el comando para crear cotas lineales 

2. En las propiedades de tipo  seleccionar el tipo de cota y modificar sus 
propiedades si es necesario 
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 figura 137 

 
 Los parámetros de gráfico permiten definir:  
 

 Tipo de flecha de la línea de cota ( Tick Mark) 

 Visualización de línea de extensión (Witness Line control) 

 Distancia entre el objeto y la línea de extensión de la cota (Witness Line 
Gap to Element) 

 Color de la cota 
 

Los parámetros de texto permiten definir: 
 

 Tamaño del texto de cota (Text Size) 

 Ubicación del texto sobre la línea de  cota ( Read Convention) 

 Estilo de texto 

 Unidades alternas para acotar un mismo elementos con dos unidades 
de medida diferentes (Alternate Units) 

 Colocación del valor de altura en puertas, ventanas y huecos (Show 
Opening Height) 

 
3. Seleccionar el muro  
4. Hacer clic en el sitio donde colocará la cota. 

 
 
Cotas igualitarias 
 
Las cotas igualitarias son cotas alineadas consecutivas que permiten establecer una 
distancia igualitaria entre objetos. 
 
Para crear cotas igualitarias: 
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1. Activar el comando para crear cotas alineadas 
2. En la barra de herramientas de opciones, en la casilla Pick, puede escoger la 

opción  Muro completo o Referencias individuales. 
3. Según el elemento a acotar (pueden ser muros, puertas, o ventanas) en la 

justificación escoger Wall centerline. 
4. Hacer clic de forma continua sobre los ejes de muro o centro de puertas y 

ventanas según sea el caso. 
 

 
figura 138 

 
5. Hacer clic en el sitio donde se va a colocar la cota continua 

 

 
figura 139 

 
6. Para hacer la cota igualitaria, es decir que los elementos se distribuyan de forma 

equitativa de acuerdo a las referencias indicadas a la cota. Hacer clic sobre el 

icono  que se muestra sobre el valor de las cotas, cuando esta esta 
seleccionada 

 
 

 
figura 140 

 
7. Para que se muestre en el texto de las cotas, los valores de las distancias, 

seleccionar la cota 
8. En las propiedades de instancia, bajo el grupo de parámetros Others, en la casilla 

Equality Display, escoger opción Value 
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figura 141 

 
Formulas en cotas 
 
Las formulas son una alternativa de etiquetas en las cotas, estas solo aplican sobre cotas 
consecutivas igualitarias. El objetivo de mostrar la etiqueta con una  fórmula es dar una 
idea clara del criterio aplicado para establecer los espacios de forma igualitaria.  
 
Para crear una etiqueta de fórmula en una cota: 
 

1. Crear la cota igualitaria 
2. Seleccionar la cota y entrar a las propiedades de tipo 
3. Bajo el grupo de parámetros Other, hacer clic sobre el botón que esta frente a la 

opción Equality Formula 
 

 
figura 142 

 
En la caja de dialogo Formula igualitaria para cotas, en el listado de parámetros de 
dimensión, escoger los parámetros de acuerdo a lo que se quiere  mostrar en la 
etiqueta. Por ejemplo en la imagen a continuación la cota continua esta dividida en 
4 segmentos que generan espacios iguales de 5.95 m de longitud cada espacio, el 
total de longitud desde el primer muro hasta el ultimo es de 23.80. 
 

 
figura 143 

 
4. En la caja de dialogo de formulas igualitarias para generar la fórmula seleccionar 

los parámetros en un orden especifico  
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figura 144 

 
 Donde: 
 
 Number of Segment: es la cantidad de segmentos de la cota continua 

Length of Segment: es la longitud de cada cota que forma parte de la cota 
continua. 
Total Length: es la longitud total de la cota continua 
 

5. Bajo las columnas Prefix o Suffix, debe colocar el valor de los prefijos o sufijos que 
se requiere que acompañen a cada valor de la formula. 

 
6. Para activar la visibilidad de la etiqueta con la formula, manteniendo seleccionada 

la cota, en las propiedades de instancia, bajo el grupo de parámetros Other, 
desplegar la casilla  Equality Display y escoger opción Equality Formula. 
 

 

 
figura 145 

 
Cotas lineales 
 
Las cotas lineales son horizontales o verticales y miden la distancia entre dos puntos de 
referencia 
 
Para crear cotas lineales: 

1. Escoger pestaña Annotate => Panel Dimension => icono  (Linear) 
2. Escoger el tipo de cota en las propiedades de tipo 
3. Hacer clic sobre el primer punto de rerencia 
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4. Hacer clic sobre el segundo punto de referencia 
5. Hacer clic donde va a ubicar la cota 

    
 
  
 

 
figura 146 

 
 
 
Cotas angulares 
 
Las dimensiones angulares se pueden colocar en puntos de referencia múltiples que 
comparten una intersección común. 
 
Para colocar una cota angular: 

1. Escoger pestaña Annotate => Panel Dimension => icono  (Angular) 
2. Seleccionar el tipo de cota 
3. Hacer clic sobre un punto sobre el primer elemento 

 

 
figura 147 

 
4. Hacer clic sobre el segundo punto del elemento que comparte un punto en común 

con el primer elemento seleccionado 
 

 
figura 148 
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5. Hacer clic en el sitio donde se va a colocar la cota 
 

 
figura 149 

 
Cota Radial 
 
Coloca una cota de radio sobre un arco o circulo. 
 
Para colocar una cota radial: 

1. Escoger pestaña Annotate => Panel Dimension => icono  (Radial) 
2. Seleccionar el tipo de cota 
3. Hacer clic sobre el arco o circulo a acotar 
4. Hacer clic en el sitio donde se va a colocar la cota 

 
Cota de diámetro 
 
Coloca una cota de diámetro sobre un arco o circulo. 

1. Escoger pestaña Annotate => Panel Dimension => icono  (Diameter) 
2. Seleccionar el tipo de cota 
3. Hacer clic sobre el arco o circulo a acotar 
4. Hacer clic en el sitio donde se va a colocar la cota 

 

 
figura 150 

 
Cotas de longitud de arco 
 
Puede sacar las dimensiones de los muros curvos, obteniendo la longitud total de la 
pared. 
 
Para crear una cota de longitud de arco: 

1. Escoger pestaña Annotate => Panel Dimension => icono  (Arc Length) 
2. Seleccionar el tipo de cota 
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3. Hacer clic sobre el arco a acotar 
4. Seleccionar la referencia con la que se intercepta el primer extremo del arco 
5. Seleccionar la referencia con la que se intercepta el segundo extremo del arco 
6. Hacer clic en el sitio donde se va a colocar la cota 

 

 
figura 151 

 
Spot Elevation 
 
Coloca la cota de elevación actual del punto seleccionado. Las cotas de elevación 
también puede mostrar la elevación de la parte superior y / o inferior de los elementos con 
un espesor. 
 
Para colocar una cota Spot Elevation: 

1. Escoger pestaña Annotate => Panel Dimension => icono  (Spot Elevation) 
2. Seleccionar el tipo de cota 
3. Hacer clic sobre el elemento  a acotar 
4. Luego especificar la ubicación de la flecha directriz 
5. Y por ultimo la ubicación de la cota de elevación 

 

 
figura 152 

 
Spot Coordinate 
 
Coloca la cota de la coordenada actual del punto seleccionado. 
 
Para colocar una cota Spot Coordinate: 

1. Escoger pestaña Annotate => Panel Dimension => icono  (Spot Coordinate) 

http://www.darco.com.mx/


 

85 

DERECHOS RESERVADOS DARCO S.A. DE C.V.  2015 
www.darco.com.mx  

 

2. Seleccionar el tipo de cota 
3. Hacer clic sobre el elemento  a acotar 
4. Luego especificar la ubicación de la flecha directriz 
5. Y por ultimo la ubicación de la cota de coordenada 

 

 
figura 153 

 
Restricciones en cotas permanentes 
 
Las cotas  permanentes por defecto no tienen restricciones, lo cual indica que se puede 
cambiar las dimensiones o distancias de los objetos asociados a la cota. Al crear una 
restricción sobre la cota, no se podrá modificar las dimensiones o distancias. Cuando el  

icono en forma de candado  se muestra cerrado significa que cota está restringida. 
 
Otro tipo de restricción en cotas, son las restricciones igualitarias (Equality Constraints), 
que definen distancias iguales entre las intersecciones de muros. El icono de restricciones 

igualitarias  se muestra cómo cuando no existe restricción. 

 
Para  restringir una cota: 
 

1. Seleccionar la cota a restringir 

2. Hacer clic sobre el icono de candado  
 

 
figura 154 

  
Para crear una restricción igualitaria: 
 

1. Acotar el muro, usando la opción Intersección de muros 
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figura 155 

 
2. Seleccionar la cota 

3. Hacer clic sobre el icono  
 

 
figura 156 
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Textos 

 
Los textos permiten colocar notas de texto en la vista actual. Se puede colocar líneas de 
texto simple o párrafos de texto completos numerados, con sangría, con líneas directrices, 
etc. 
 
Para colocar un texto: 
 

1. Escoger pestaña Annotate => panel Text => icono  
2. Se despliega la pestaña contextual Modify Place Text 

 

 
figura 157 

 
Para colocar un texto simple: 
 

1. En la pestaña contextual Modify Place Text => panel Format => escoger icono 

 (text) 
2. En el selector de tipos puede escoger el tipo de texto a usar 
3. En la propiedades de tipo, puede configurar las opciones relacionadas con 

tamaños de texto, fuente, color etc. 
4. Hacer clic en el sitio en la vista donde se va a escribir el texto 
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figura 158 

 
Para agregar líneas directrices a un texto: 
 

1. Seleccionar un texto ya existente 
2. En la pestaña contextural Modify Text Notes =>  en el panel Format => escoger 

cualquiera de las opciones de directrices mostradas, dependiendo de la dirección, 
lado y apariencia de la directriz 

 

   
figura 159 

 
Para agregar más de una línea directriz en un texto: 
 

1. Seleccionar el texto que ya tiene por lo menos una directriz 
2. En la pestaña contextural Modify Text Notes =>  en el panel Format => escoger 

cualquiera de las opciones de directrices mostradas, dependiendo de la dirección, 
lado y apariencia de la directriz 
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figura 160 

 
Para eliminar líneas directrices en un texto: 
 

1. Seleccionar el texto que ya tiene por lo menos una directriz 
2. En la pestaña contextural Modify Text Notes =>  en el panel Format => escoger 

opción  (Remove Last Leader) 
 

Cada vez que haga clic sobre el icono las directrices se irán elíminando en 
orden desde la última creada. 
 

Para colocar párrafos de texto numerado: 
 

1. Escoger pestaña Annotate => panel Text => icono  
3. En la pestaña contextural Modify Text Notes =>  en el panel Format => escoger 

cualquiera de las opciones de colocación de párrafos de texto 
 

 
figura 161 

 
2. Seleccionar o configurar tipo de texto 
3. Hacer clic en el sitio donde se va a colocar el párrafo de texto 
4. En el panel Format escoger cualquiera de las opciones de numeración para las 

líneas de texto 
 

 
figura 162 

 
5. Escribir el texto correspondiente 
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figura 163 

 
6. Terminado de escribir el texto, hacer clic en cualquier parte fuera del cuadro de 

texto. 
 
Para cambiar la justificación de un texto: 
 

1. Seleccionar el texto al cual se requiere cambiar la configuración de justificación 
2. En el panel Format escoger cualquiera de las opciones de justificación del texto 

 

 
figura 164 
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Trabajo con Tags   

 
Los tags son etiquetas informativas que están vinculadas a los elementos modelo del 
proyecto. A todos los elementos modelo es posible colocarles un tag.  
 
Los tags son anotaciones que se definen en familias cargables, además se puede 
configurar un tag por defecto que esté vinculado a un elemento modelo. 
 
 

Etiquetas en sistema de vigas 
 
Las etiquetas nos permiten rastrear información de los componentes (familias) y poder 
insertarla en cualquier  vista para documentar un proyecto 

 Etiqueta con la herramienta beam annotations  
 

 

figura 165 

 
1.  Crear etiqueta para el sistema de vigas 

Menú de aplicaciones  --New family- Plantilla – en la carpeta de annotations- 

Generic Annotations. 
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figura 166 

 
Nota: al abrir la plantilla  de Generic Annotation nos muestra 2 planos de Referencia que  

indican  el punto de inserción, antes de iniciar una etiqueta definir la categoría con la cual 

se va a trabajar  (Eliminar el Texto de color rojo) 

2. Definir la categoría – en el icono de Family Category  

Seleccionar   Structural Framing Tags y habilitar la opción --- rotate With component  

 

figura 167 

 
3. insertar etiqueta  
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En la ficha de Create – en el panel Text—seleccionar la herramienta Label  

4. Definir la ubicación de la etiqueta sobre  la plantilla, al dar click nos muestra 

La paleta con todos los parámetros que puede insertar en una etiqueta, Revit permite 

insertar múltiples  campos 

 

figura 168 

 
5. Seleccionar la opción  (Type Name)  agregarlo a la lista de etiqueta de parámetros  

6. Definir la ubicación de la etiqueta tomando en cuenta que la intersección de los 

planos de referencia son el centro de la etiqueta  

7. Crear el tipo de  Texto en la opción de familia Type  

 

figura 169 

 
8. Definir las características del texto , tamaño, color, formato ,etc 
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figura 170 

 

9. Guardar la familia  

10. Cagar la familia en el proyecto a documentar 

11. En la ficha de Modify—en el panel—Family Editor – Load Into Project  

12. Para insertar la etiqueta en la categoría de Structural Framing, con la herramienta 

de   

13. En la ficha Annotate – en el panel Tag – en la herramienta   se 

define el tipo de etiqueta que se utilizara para documentar  
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figura 171 

 
14. En la ventana Beam Annotations  define el tipo de etiqueta y la ubicación en la cual 

la necesita (inicio-centro-final). 

15. una vez que se ha terminado  de configurar el cuadro de dialogo, darle Ok 

El programa le asignara una etiqueta por cada viga 
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figura 172 

 

Etiqueta de Armado (rebar) 
 
Las etiquetas de la categoría Structural Rebar, rastrea la información con respecto a los 
elemento de refuerzo (estribos,  barras, ganchos, bastones) 

 

figura 173 
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Para crear etiqueta para la categoría Ribar (estribos, barras, ganchos, etc ) 

1. Menú de aplicaciones  --New family- Plantilla – en la carpeta de 

annotations- Generic Annotations. 

 

figura 174 

 

Nota: al abrir la plantilla  de Generic Annotation nos muestra 2 planos de Referencia que  

indican  el punto de inserción, antes de iniciar una etiqueta definir la categoría con la cual 

se va a trabajar  (Eliminar el Texto de color rojo) 

2. Definir la categoría – en el icono de Family Category  

Seleccionar   Structural Rebar Tags  
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figura 175 

 

3. inserta etiqueta En la ficha de Create – en el panel Text—seleccionar la 

herramienta Label  

4. Definir la ubicación de la etiqueta sobre  la plantilla, al dar click nos muestra 

5. La paleta con todos los parámetros que puede insertar en una etiqueta, Revit 

permite insertar múltiples  campos 
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figura 176 

 
6. Seleccionar los Fields que necesita rastrear  en la etiqueta.  

Ejemplo  E 3/8”@ 20 cm donde E es un prefijo-3/8” es Bar diameter- @ es un sufijo 

y 20 cm es el fields de spacing 

7. Definir la ubicación de la etiqueta tomando en cuenta que la intersección de los 

planos de referencia son el centro de la etiqueta  

8. Crear el tipo de  Texto , en la opción de familia Type  

 

figura 177 

 

Definir las características del texto , tamaño, color, formato ,etc 
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figura 178 

 
9. Guardar la familia   

10. Cagar la familia en el proyecto a documentar 

11. En la ficha de Modify—en el panel—Family Editor – Load Into Project  

 

Insertar la etiqueta creada (structural rebar tag) 

1. En la ficha de Annotate – panel Tag—herramienta  Tag by category  
2. En la barra de opciones seleccionar la herramienta Tags  

 

 
figura 179 

 
3. Y seleccionar la categoría de structural Rebar 
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figura 180 

 
4. Seleccionar  la categoría de Rebar y de acuerdo a los Fields agregados a la familia 

nos rastrea la información 

 

figura 181 

 
Simbología 
 
Un símbolo de anotación es una etiqueta o símbolo se aplica a una familia para identificar 
de forma única a esa familia en un proyecto. 
 
Puede crear símbolos de anotación seleccionando la categoría de la familia con la que 
desea asociar el símbolo, el dibujo del símbolo, y la aplicación de los valores de sus 

propiedades. Algunas familias de anotación son para fines de etiqueta. Otros son 
anotaciones genéricas utilizadas para fines diferentes. 
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Tagging Beam Systems 
 
Etiquetas de encuadre son etiquetas de armazón estructural que, por defecto, se alinean 

en paralelo en el centro superior de las vigas creadas en el sistema. Puede modificar 
estas ubicaciones de códigos utilizando la herramienta de anotación viga. 
 
Para etiquetar el sistema de vigas con la elaboración de etiquetas, haga clic en la ficha 

Anotar panel de Tag (Beam Anotaciones).   
 

Beam códigos span - sistema son exclusivas de los sistemas de vigas. Estas etiquetas se 

muestran como un lapso flecha perpendicular a las vigas creadas en el sistema. Su 
etiqueta indica su tipo de marco estructural y su separación en el sistema de vigas (tipo 
viga @ separación). 
 
Para etiquetar el sistema de vigas con códigos span sistema de vigas, haga clic en la 

ficha Anotar panel de Symbol (Beam).   
 

Tag Area Reinforcement 
 
Puede anotar la región zona de refuerzo utilizando símbolos y etiquetas 
personalizadas. Esto proporciona información sobre el tipo de refuerzo y los detalles de 
límites específicos. 
 
Publicar un Estrado Símbolo Área 
 

1. Haga clic en la ficha Anotar panel de Symbol (Símbolo Refuerzo de área).  
 

Nota: Puede cargar símbolos de refuerzo de la Biblioteca si no existe en el  
proyecto. 

 
2. Seleccione el área de refuerzo en el que colocar el símbolo. 

 
figura 182 

 
3. Posición y haga clic para colocar el símbolo área de refuerzo. 

 
Publicar un Tag Refuerzo de área 
 

4. Seleccione la ficha Anotar panel de Tag (Etiqueta Por categoría).  
 

Nota: Puede cargar etiquetas de refuerzo de la Biblioteca si no existe en el 
 proyecto. 
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5. Seleccione el área de refuerzo en el que colocar la etiqueta. 

 

 
figura 183 

 
Puede incluir las principales propiedades de espaciado editando la etiqueta de la 
etiqueta.Bottom / Interior Mayor espaciamiento y Top / Exterior Mayor espaciamiento son 
Parámetros de categoría disponibles. 
 

6. Presione ESC para salir de la herramienta de Tag. 

 
Nota: Para resolver errores de redondeo que pueden manifestarse cuando el 
etiquetado área de refuerzo, puede modificar las unidades de medida para el 
volumen de refuerzo y longitud. Haga clic en la ficha Administrar panel de 
configuración (Unidades de Proyectos). Bajo Refuerzo de volumen o Estrado 
Longitud, ajustar las unidades, el redondeo y la representación símbolo según sea 

necesario.  
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Edición de familias de planos 
 
Son las plantillas para planos. Generalmente incluyen un borde para la página e 
información  acerca de la empresa de diseño, tales como nombre, dirección  y logo. El 
pide de plano puede además desplegar información acerca del proyecto, cliente y planos 
individuales, incluyendo fechas de creación y revisión. 
 
El pie de plano se crea o edita en el editor de familias, en cada pie de plano debe 
especificar tamaño de hoja, logotipo, bordes y otra información del proyecto. Los pie de 
plano se graban como archivos separados con extensión *.RFA. 
 
Estos archivos de familia luego pueden ser cargados en la plantilla o en el proyecto. Si los 
carga directamente en la plantilla, estos estarán disponibles automáticamente en 
cualquier proyecto que use esa plantilla. 
 
Para abrir una familia de planos: 
 

1. Escoger Menú  => Open => opción Family 
2. En la carpeta Titleblocks seleccionar la familia, de cuerdo al tamaño de hoja a 

configurar 
 

 
figura 184 

 
3. Presionar el botón Open para abrir el archivo de familia 

 
Labels (Etiquetas) 
 
Las etiquetas (Labels) pueden ser colocadas sobre el pie de plano, y su función es tomar 
información del proyecto como por ejemplo; el nombre, cliente, fecha, número del 
proyecto etc., y colocarlo sobre el pie de plano como un texto automático. Cuando un 
cambio sea hecho en una vista principal, todos los planos asociados se actualizarán. 

 
Para trabajar con etiquetas: 
 

1. Abrir el archivo de familia a editar 

2. En el editor de familias, escoger la pestaña Create => Panel Text => icono  
(Label) 

3. Hacer clic en el sitio donde la etiqueta será colocada 
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4. En la caja  ddialogo Edit Label escoger en el listados de categorías de etiquetas  
 

 
figura 185 

 

5. Hacer clic en el botón  (Add parameter) para agregar el parametro a la lista. 
6. Presionar el botón OK 
7. La etiqueta será colocada en el sitio indicado. Las etiquetas solo muestran los 

valores de texto cuando son cargados en un proyecto. 

 
figura 186 

 
De los nodos que están en los extremos se puede cambiar el tamaño del recuadro 
del campo. Usando la marca de rotación que se encuentra en la parte superior 
derecha del recuadro, se puede rotar el texto. Desde la paleta de propiedades 
puede cambiar las propiedades del texto de la etiqueta. 

 

Para insertar una imagen: 

1. En el editor de familias, escoger pestaña Insert => panel Import => icono  
2. Buscar y seleccionar la imagen a importar 
3. Hacer clic en el sitio donde ubicará la imagen 
4. Usando los nodos que se encuentran en las esquinas de la imagen, se puede 

cambiar su tamaño. 

 
figura 187 

 
Para cambiar el tamaño de la hoja: 
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1. Para saber el tamaño de la hoja, puede usar la herramienta de medición entre dos 

puntos, para esto escoger pestaña Modify => Panel Measure => icono  
(Measure Between to References) 

2.  Definir primer punto y luego segundo punto 
 

   
 figura 188 

3. Seleccionar la primera línea a cambiar la longitud y arrastrarla desde uno de los 
nodos en los extremos 

 
figura 189 

 
En caso de que se muestre una advertencia que indica que los elementos (las 
líneas no pueden permanecer unidas, presionar el botón Unjoin Elements. 

 
4. Usando el mismo procedimiento ajustar el resto de líneas de acuerdo al tamaño de 

la hoja a configurar. 
5. Grabar el archivo de familia en una carpeta de trabajo especifica. 

 
Para colocar textos: 

1. Escoger la pestaña Create => panel Text => icono  (Text) 
2. Hacer clic sobre el sitio donde el texto va a ser colocado 
3. Escribir el texto 
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4. En el panel Select, escoger icono  (Modify) para terminar el comando 
 

Para modificar el estilo del texto: 
 

1. Seleccionar el texto 

2. En la paleta de propiedades escoger opción  
3. En la paleta de propiedades de  tipo, bajo el grupo de parámetros Text definir las 

propiedades de fuente, tamaño y propiedades del texto. 
 

 
figura 190 

 
Para cambiar el contenido del texto: 
 

1. Hacer doble clic sobre el texto al cual se le va a cambiar el contenido 
2. Escribir el nuevo contenido  y hacer clic en cualquier parte fuera del recuadro que 

indica el área del texto 
 
Tags y cotas en vistas 3D 

 
Puede colocar tags y cotas en vistas 3D, pero antes será necesario que la vista sea 
bloqueada. Cuando se desbloque la vista 3D y se cambia el punto de vista, las cotas y 
tags que hayan sido colocados se perderán. 
 
 
Preparar una vista 3D para colocar tags y cotas: 
 

1. Abrir o crear una vista 3D y definir el punto de vista que se requiera usar para 
colocar tags o cotas 

2. En la barra de herramientas de controles de vista, hacer clic sobre el icono  
(unlocked 3D View) y luego la opción Save Orientation and Lock View 
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figura 191 

 
3. Asignar un nombre a la vista 3D 
4. Agregar Tags y cotas, sin cambar la orientación de la vista. Puede ejecutar los 

comandos Zoom y Pan 
 

 
figura 192 
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Configuraciones generales de Revit 

 
Creación de una plantilla (Template) 
 
Las plantillas sirven para crear nuevos proyectos que incluyan los estándares de diseño 
que se usan en la oficina. 
 
En una plantilla de Revit se pueden definir lo siguiente: 
 

 Información del proyecto, tal como  nombre, número, dueño, dirección etc. 

 Configuraciones tales como; estilos de línea, patrones de rellenos para materiales, 
unidades del proyecto, incremento de snaps para las vistas modelo. 

 Los sistemas de familia a usar, también puede duplicar y modificar las familias 
usadas con más frecuencia para personalizarlas de acuerdo a los requerimientos 
de proyecto 

 Pie de plano y formatos de tamaño para las vistas de planos 
 
Para crear una plantilla: 
 

1. Escoger  menú de aplicaciones =>opción   => 

herramienta  
2. En la caja de dialogo New Project desplegar la casilla Template file 
3. Escoger la plantilla de proyecto a usar 

 

 
figura 193 

 
También puede presionar el botón Browse para escoger la plantilla base que 
usará. 

4. En la sección Create New escoger Project Template 
 

 
 

Un archivo de plantilla en Revit tiene extensión *.RTE. Los archivos de plantilla tienen  
una interfaz igual a la de un archivo de proyecto. 
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Una vez creado el archivo de plantilla, se deben definir las configuraciones básicas que se 
usaran para todos los proyectos. 
 
Configurar listado de plantillas  
 
Es posible especificar los archivos de plantilla que se usan con más frecuencia en una 
lista, que se mostrará en la ventana New Project, bajo la sección Template file. 
 
Para configurar plantillas en el listado de plantillas: 
 

1. Desplegar el Menú de aplicaciones => escoger Options 
2. En el lado izquierdo de la caja de dialogo de opciones, seleccionar la opción File 

Locations 

3. Bajo la sección Project Template Files: hacer clic sobre el botón  (Add Value) 
4. Buscar y seleccionar la plantilla que se requiere agregar a los listados 

 

 
figura 194 

 
 
Para limpiar la plantilla de familias que no se van a usar: 
 

1. Escoger pestaña Manage => Panel Settings => icono  
2. Para quitar la selección de los tipos, que por defecto estan seleccionados 

presionar el botón Check None 
 

 
figura 195 

 

http://www.darco.com.mx/


 

111 

DERECHOS RESERVADOS DARCO S.A. DE C.V.  2015 
www.darco.com.mx  

 

3. Desplegar las categorías y revisar familias y tipos que se quieren eliminar de la 
plantilla, activando el recuadro que se encuentra al lado izquierdo de la familia o 
tipo. 

 

 
figura 196 

 
4. Presionar el botón OK para purgar la plantilla 

 
 
 
Ajustes del Proyecto  
 
Revit permite definir varios ajustes a  los elementos según  requisitos particulares del 
proyecto. Por ejemplo se pueden definir; tipos de relleno, estilos de línea, tags de 
símbolos de vistas de elevación y detalles, cotas, materiales etc.  
 
Para acceder a las opciones de configuraciones de estilos: 

Escoger pestaña Manage => Panel Settings =>  (Additional Settings) 
 

 (Patrones de relleno) Los patrones de relleno controlan el aspecto de las 
superficies cuando aparecen íntegras o cortadas en el plano proyectado. Utilice la 
herramienta Patrones de relleno para crear o modificar patrones de diseño y de modelo. 
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figura 197 

 
Los patrones de modelo representan el aspecto real de un elemento en la construcción, 
por ejemplo una hilada de ladrillos o los azulejos de un muro, y son constantes con 
relación al modelo. Eso significa que cambian de escala con el modelo. Así pues, 
cualquier modificación en la escala de la vista también afecta a las escalas de los 
patrones. 
 
Los patrones de diseño representan materiales de forma simbólica; por ejemplo, la arena 
se representa mediante un patrón de punteado. La densidad de los patrones de diseño es 
constante con relación al plano de dibujo.  
 
Para cargar patrones de relleno a una plantilla o proyecto: 
 

1. Abrir el archivo de plantilla o proyecto 

2. Escoger pestaña Manage => Panel Settings =>  (Additional Settings) => 

 
3. En la caja de dialogo Patrones de Relleno, verificar que la opción Drafting en la 

sección Tipo de patrón este activada 
4. Presionar el botón New 
5. En la caja de dialogo Nuevo patrón asignar un nombre al patrón de relleno 
6. Presionar el botón Import para importar el patrón de relleno. Este debe estar 

definido en un archivo *.pat 
7. Definir la escala de importación del patrón de relleno. 
8. Aceptar los cambios hasta salir del cuadro de dialogo de creación de relleno 
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figura 198 

 
NOTA: La escala asignada a un patrón de relleno en el momento de la importación no se 
puede cambiar. 
 

 (Estilos de línea) Los estilos de línea se utilizan para crear diferentes 
efectos, por ejemplo, una línea discontinua (------) para los planos de referencia. Cuando 
se instala y ejecuta Revit Architecture, se incluyen varios estilos de línea. Cada estilo de 
línea predefinido tiene un nombre que describe la línea en sí (por ejemplo, Trazo punto) o 
el lugar donde Revit Architecture utiliza el estilo de línea (por ejemplo, Líneas <boceto>). 
Revit Architecture almacena los estilos de línea en la plantilla predeterminada. 
 
En el editor de familias no se pueden crear estilos de líneas nuevas, pero sí modificar el 
grosor, color y patrón de las líneas. 
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figura 199 

 
Para crear un estilo de línea: 

1. Escoger pestaña Manage => Panel Settings => Desplegar  => opción 

 
2. Presionar el botón New 
3. En la caja de dialogo New Subcategory, asignar un nombre al estilo de línea 
4. En el listado de estilos de línea, cambiar la configuración requerida en cuanto a 

color, grosor y patrón. 
 

 
figura 200 

 

 (Grosores de línea) Puede controlar los grosores de línea para las líneas 
de modelo, perspectiva y anotación.  
 
En las líneas de modelo, puede especificar el grosor de línea para componentes de 
modelo, como puertas, ventanas y muros, en vistas ortogonales. El grosor de línea 
depende de la escala de la vista.  
 
Para especificar los grosores de línea en un componente modelo: 
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1. Escoger pestaña Object Styles => panel Settings => icono  (Object Styles) 
2. En la caja de dialogo estilos de objeto, activar la pestaña Model Object 
3. Seleccionar y desplegar la categoría de objeto a asignar un grosor de línea 
4. Seleccionar todos los componentes de la categoria (subcategorías) a los cuales se 

requiere asignar un grosor de línea. 
 

 
figura 201 

 
5. Tanto bajo las columnas Projection y Cut escoger el grosor de línea que se 

requiere asignar a la categoría. 
6. Presionar el botón Aceptar para salir del cuadro de dialogo y confirmar los 

cambios. 
 
Para líneas de perspectiva, puede especificar grosores de línea para componentes de 
modelado en vistas de perspectiva. Si lo desea, puede aplicar diferentes estilos y 
grosores de línea con la herramienta Tipo de línea. En las líneas de modelo, puede 
controlar el grosor de línea para objetos de anotación, como las líneas de sección y cota. 
Los grosores de los símbolos de anotación no dependen de la escala del diseño. 
 
Para definir grosores de línea: 

1. Escoger pestaña Manage => Panel Settings => Desplegar  => opción 

 
2. Presionar el botón Add 
3. En la caja de dialogo Agregar escala, seleccionar el valor de la escala de vista que 

se requiere usar para la nueva configuración de grosores de línea. 
 

 
figura 202 
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Los grosores de línea se configuran de acuerdo con los grosores de puntas en 
milímetros. 
 

Las opciones; Los símbolos de llamada, Elevación, Sección, Flechas de líneas de cota y 
dimensiones temporales, permiten seleccionar la familia de anotaciones que se usará por 
defecto para símbolo de vistas de detalle, elevaciones, secciones, líneas de cota, además 
cambiar propiedades de tipo como el tamaño de las flechas de cota. Los símbolos de 
etiquetas están definidos en las familias de anotaciones.  
 

 
 
Para asignar o cambiar los símbolos: 
 

1. Abrir el archivo de familia correspondiente y editarlo. Los archivos de familia de 
etiquetas se encuentran en la carpeta Annotations, los nombres de archivos de 
familia identifican el tipo de símbolo que contienen. Por ejemplo las familias que 
comienzan con los nombres: M_Section_Head, son familias de símbolos de 
secciones. M_Elevation, son familias de símbolos de elevaciones etc. 

 
2. Grabar el archivo de familia con otro nombre (se recomienda grabar las 

modificaciones como otro archivo de familia para conservar el archivo de familia 
original) 

3. En el editor de familias, escoger Pestaña Create => Panel Family Editor => 

icono (Load into Project) 
 

Para este procedimiento es necesario tener abierto el proyecto o plantilla en el 
cual se requiere cargar la familia. 

4. Escoger Pestaña Manage => Panel Settings => icono  (additional Settings) 
 
Escoger cualquiera de las opciones mensionadas de acuerdo al tipo de símbolo 
que se requiere cargar. 
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Creación de un proyecto 
 
En Revit un proyecto es el diseño entero del edificio y la documentación asociada a este.  
Todas las vistas estándares del edificio, y las tablas de cuantificación se incluyen en el 
proyecto.  Siempre que se cambie el modelo, todas las visitas relacionadas, los dibujos, y 
las tablas se ponen al día automáticamente.   
 
Para iniciar un proyecto no se requiere un procedimiento rígido ni estandarizado, este 
puede iniciarse de diversas formas dependiendo las necesidades y complejidad, pero si 
se requiere tener una estrategia definida, antes de empezar a incluir cualquier 
componente en el proyecto, así que antes de iniciar un proyecto se tienen que tener en 
cuente algunas de las siguientes sugerencias: 
 

 Configurar unidades de medida 

 Definir el número de niveles con los que cuenta el edificio 

 Iniciar el trazo preferentemente con los muros exteriores 

 Ligar el comportamiento de los muros con los niveles 
 
Cuando se comienza un nuevo proyecto se crea dos niveles de información por defecto, 
además se realizan automáticamente varias funciones.  Primero, se carga un archivo 
plantilla que contiene un subconjunto de componentes y de ajustes del sistema.  Esto 
pone los componentes a disposición para que el usuario comience  a crear su diseño.  
Los componentes individuales se van creando por el usuario más adelante, según los 
vaya necesitando.   
 
Para crear un proyecto Nuevo: 
 

1. Escoger icono   => New 
2. Escoger Una plantilla. Puede ser en unidades métricas o inglesas 

 
La extensión de los archivos de proyecto de Revit es *.rvt 
 
Pueden definirse plantillas personalizadas con las configuraciones específicas que el 
usuario sabe que siempre serán usadas para sus proyectos. Por ejemplo unidades de 
medida, familias de elementos, propiedades de objetos, tamaño de láminas de impresión, 
etc. 
 
Información del proyecto 
 
En la caja de dialogo información del proyecto, se incluye información básica relacionada 
con el proyecto como el nombre, número, cliente etc. 
 
Para  agregar información del proyecto: 

1. Escoger pestaña Manage => Panel Settings => icono  (Project information) 
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figura 203 
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Componentes de Detalles: Los componentes de detalle están disponibles con Revit para 
ayudar a crear las vistas de detalles o callout.  Se pueden también crear componentes 
propios o descargarlos de las bibliotecas que vienen con Revit. Estos componentes están 
definidos en familias y son 2D,  son visibles solamente en la vista en la cual se han 
colocado.   
 
Para activar los componentes de detalle: 
 

1. Escoger pestaña Annotate => Panel Detail 
 

 
figura 204 

 
Se pueden crear vistas callout y utilizar  componentes de detalle ya que estos conservan 
las capacidades paramétricas de Revit.   
 
Revit proporciona herramientas para asistir al usuario en la creación de los detalles:  
 

 Detail lines: Son utilizadas para dibujar encima de las vistas callouts 

 Dimensions: Aplica dimensiones específicas al detalle.   

 Text notes: Crea anotaciones en los detalles. 

 Detail components: Estos componentes son elementos de detalle 2D,  son       
visibles solamente en la vista en la cual se han colocado. Revit contiene alrededor 
de 500 familias de componentes de detalle, los cuales están organizados en 
carpetas de acuerdo a las 16 divisiones establecidas por la CSI (Construction 
Specifications Institute)  

 Symbols: Son marcas tales como una flecha de dirección o la marca de corte, 
niveles, etc. 

 filled regions: Son patrones de relleno  para representar varias superficies como: 
concreto, tierra etc. Para crear estos patrones hay que dibujar las regiones en un 
plano de trabajo. 

 Insulation: Crea un patrón de sombreado que representa el aislamiento en un 
detalle de pared   

 Revision clouds: Las nubes de la revisión se pueden dibujar para indicar las 
áreas que se han revisado. 

 
Para agregar componentes de detalle: 
 

1. Activar la vista Callout correspondiente 

2. Escoger pestaña Annotate => Panel Detail =>  icono  component 
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3. En la pestaña contextual Modify Place Detail Component => panel Mode => 

escoger icono  (Load Family), para cargar familias de componentes 
4. La carpeta Detail components contiene todas las familias de componentes de 

detalle 2D 
5. Seleccionar el componente de detalle, cargarlo en el proyecto y colocarlo sobre la 

vista de detalle. 
 

 
figura 205 

 
Para crear una región con relleno: 
 

1. Activar la vista de detalle correspondiente 

2. Escoger pestaña Annotate => Panel Detail =>  icono  Region 
3. En el panel Draw, escoger la herramienta para trazar el contorno de la región 

 

 
figura 206 

 
4. Dibujar el contorno 

 
figura 207 

 

5. En las propiedades de tipo   asignar el patrón de relleno 
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figura 208 

 

6. Para crear la región hacer clic sobre el icono  
 

 
figura 209 
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Planos  

 
Son llamadas también hojas de dibujo, las cuales generalmente incluyen un rotulo con 
información acerca del proyecto. Básicamente los planos, son las láminas de impresión 
(Layouts) que incluyen diferentes vistas del proyecto.  
 

 
Figura 210 

 
Cada vez que una hoja es creada, se lista bajo la opción Sheets (all) en el Project 
browser. 
 
Guide Grids (Cuadrículas) 
 
También es posible agregar cuadrículas sobre los planos, las cuales servirán de 
referencia para determinar y alinear la ubicación de las vistas. 
 
Para cargar una familia de plano a un proyecto: 

1. Escoger pestaña Architecture => Panel Family Editor => icono  (Load into 
Project) 

2. Buscar la familia de pie de plano a usar. Por defecto los formatos de pie de plano 
que incluye Revit estan en la carpeta Titleblocks. 

 
Para crear un plano en un proyecto: 

1. Escoger pestaña View => Panel Sheet Composition => icono  
2. En el listado de planos, escoger el tipo a usar 
3. Asignar nombre y número al plano desde el pie de plano o desde el Project 

Browser 
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figura 211 

 
Agregar una cuadricula sobre el plano: 
 

1. Escoger pestaña View => Panel Sheet Composition => icono  
2. Asignarle un nombre a la cuadrícula 
3. Seleccionar la cuadricula sobre el plano y ajustarla arrastrando los nodos que 

están en los extremos. 
 

 
figura 212 

 
4. En las propiedades de instancia en la casilla Guide Spacing, se puede cambiar el 

tamaño de las celdas. 
 
Para incluir vistas en un plano: 
 

4. Seleccionar la vista y arrastrarla sobre el plano 
5. Hacer clic en la ubicación sobre el plano 

6. Usando el comando  puede ajustar la vista con la cuadrícula 
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Cuando en un plano se incluyen vistas de Sección, Callouts y de elevaciones, los 
símbolos de referencia en las vistas principales correspondientes, se actualizarán con el 
número de la hoja en la cual esté incluida dicha vista. 
 
Revit puede importar pie de planos creados en AutoCAD o de otras aplicaciones en 
formato DXF 
 
Para editar vistas desde un plano: 
 

1. Activar la vista de plano 
2. Seleccionar la vista a editar 

3. Escoger pestaña Modify Viewports => panel Viewport =>  (Active View) o 
hacer doble clic sobre la vista 

4. Puede seleccionar y realizar cualquier tipo de edición sobre los elementos de la 
vista activa, cambiar la escala, estilo visual, ocultar objetos etc. 

 

 
figura 213 

 
5. Para desactivar la vista que está en edición, hacer doble clic en cualquier lado 

fuera del área de la vista activa. 
 

 
Listados de planos 
 
Un listado de planos es una tabla que contiene información que se colocará en el pie de 
plano. 
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Para crear un listado de planos: 
 

1. Escoger pestaña View => panel Create => desplegar icono  => 

opción  
2. En el cuadro de dialogo Propiedades de listado de planos activar la pestaña Fields 
3. Seleccionar los campos que se incluirán en el listado 

 

 
figura 214 

 
4. Se genera una vista con la tabla. 

 

  
figura 215 

 
Para agregar los datos de los planos: 
 

1. Activar la vista del listado de planos 

2. En el Panel Rows => escoger icono  (New) 
3. Se agregará un registro en blanco a la tabla de planos } 
4. Llenar los datos para el plano. 
5. Puede agregar cuantos registros necesite de acuerdo a la cantidad de planos que 

se vayan a generar en el proyecto. 
 

 
figura 216 
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NOTA: Una vez esté trabajando en el proyecto, puede agregar planos adicionales en 
cualquier momento. 
 
 
Para crear un plano: 
 

1. Escoger pestaña View => Panel Sheet Composition => icono  
2. En la caja de dialogo Nuevo Plano escoger el pie de plano a usar y el registro con 

la información del plano 
 

 
figura 217 

 
3. Presionar el botón OK 

 
Editar títulos de ventanas en planos 
 
Los títulos de las ventanas que se colocan en los planos están definidos en familias 
cargables y son anotaciones que pueden editarse en contenido. 
 
Para editar una familia de título de ventana: 
 

1. Seleccionar el título y en la paleta de propiedades en el selector de tipos podrá 
observar el nombre de la familia a la cual pertenece. 

 

 
figura 218 
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2. Escoger menú de aplicaciones  (Menú de aplicaciones) => Open => family 
3. En la carpeta Us Mectric/Annotations, buscar los archivos de familias cuyo nombre 

comience con las letras M_Title* y escoger el archivo que necesita abrir 
 

   
figura 219 

 
4. En el editor de familias realizar las modificaciones que sean necesarias. 

 
Para agregar una etiqueta al título: 
 

1. Abrir el archivo de familia en caso de que no lo tenga abierto 

2. Escoger pestaña Create => panel Text => icono  (Label) 
3. En la vista, hacer clic en el sitio donde se quiere colocar la etiqueta  
4. En el listado de campos disponibles, escoger el dato a agregar y hacer doble clic 

sobre este 
 

 
figura 220  

 
5. Una vez colocada la etiqueta pueda ajustar el estilo y tamaño del texto desde las 

propiedades de tipo. 
 
Para asignar un título a una vista de plano: 
 

1. Cargar al proyecto el archivo de familia donde está el título que quiere usar 
2. Abrir la vista de plano a la cual asignará el título 
3. Seleccionar el título de ventana a cambiar 
4. Entrar hasta las propiedades de tipo y bajo del grupo de parámetros Graphics, 

desplegar la casilla que esta frente a la opción Title 
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figura 221 

 

Impresión 
 
Revit permite al usuario imprimir diferentes elementos de una vista como la ventana 
actual, una porción visible de la ventana actual, o las vistas seleccionadas, incluyendo 
planos.  Al imprimir utiliza tecnología WYSIWYG, esto es, lo que se ve en pantalla es lo 
que se imprime, aunque  hay algunas excepciones como:   
 

 Sin importar el color de fondo en la pantalla, el color del fondo en el trabajo de 
impresión es siempre blanco.  

  

 Por defecto, los planos de referencia, los planos del trabajo, los límites de las 
líneas de corte y las cajas del alcance no imprimen, incluso si están visibles en la 
vista.  A menos que se active la impresión  de estas en las opciones de la caja de 
dialogo de impresión.   
 

 Los objetos que se hayan ocultado o aislado con el comando Temporary 
Hide/Isolate si se imprimen 

 
Revit no requiere controladores especiales para los dispositivos de salida, basta con tener 
las impresoras o plotters instalados en el sistema operativo para puedan ser reconocidos 
por el programa. 
 
Para imprimir vistas desde Revit: 
 

1. Escoger icono  => Print => Print 
2. En caso de que se requiera imprimir varias vistas o planos, activar la opción 

Selected Views/sheets 
3. Hacer clic en el botón Select 
4. En el listado de vistas, escoger los planos o vistas a imprimir 

 
Formatos PDF y DWF 
 
Puede imprimir a archivos digitales en formatos PDF o DWF los cuales pueden contener 
una o varias vistas del proyecto en un mismo archivo. 
 
Autodesk 360 es una plataforma que permite acceder a los servicios de la nube de 
Autodesk. Actualmente en el sistema gratuito, tiene una capacidad de almacenamiento de 
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5 GB, y sólo tiene que crear un usuario y contraseña para comenzar a utilizar los servicios 
de almacenamiento de la nube de Autodesk. 
 
Para subir archivos a la nube Autodesk 360: 
 

1. Desde un navegador de internet acceder a la liga https://360.autodesk.com/ 
2. Si es la primera vez que va a acceder a Autodesk 360, será necesario crear una 

cuenta, presionar botón Crear una cuenta 
3. Ingresar los datos solicitados para crear la cuenta y presionar el botón crear 

 

 
figura 222 

 
4. En la página de inicio se encuentran las opciones disponibles para cargar y 

visualizar documentos 

5. Presionar el botón  
6. Puede arrastrar y soltar un archivo con extensión DWF para cargarlo a autodesk 

360 
7. Presionar el botón Cargar 
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figura 223 

 
8. Una vez que los archivos están cargados, podrá observarlos en las listas de 

elementos cargados 
 

 
figura 224 

 
9. Puede activar la pestaña Ver, para visualizar la información del archivo 
10. En la barra de navegación que se encuentra al lado derecho de la interface, 

puedes escoger opciones para hacer Zoom, Encuadre y colocar comentarios 
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figura 225 

 
11. Cuando activa la opción de comentarios, puede usar las diferentes opciones para 

colocar notas, estas opciones se muestran en la ventana de comentarios 
 

 
figura 226 

 
12. Al colocar un comentario, este se despliega en la ventana y comentarios y además 

se marca en la vista preliminar del modelo 
 

 
figura 227 

 
Para cargar una versión nueva de un archivo: 
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1. Si ha generado cambios en una vista y necesita cargarla nuevamente como un 

archivo DWF a Autodesk 360, debe guardar el archivo con el mismo nombre 
2. En Autodesk 360, escoger en el menú Acciones => que se encuentra al lado 

derecho de la pantalla => Cargar nueva versión 
 

 
figura 228 

 
Para compartir con otro usuario la información publicada en formato DWF: 
 

1. En Autodesk 360, desplegar Menú Acciones => opción Compartir, puede 
escoger, compartir la información con un único usuario o compartirlo a cualquier 
usuario que tenga acceso a la liga. 

 
Para imprimir a formatos DWF: 
 

1. Escoger icono  => Export =>  
2. Puede crear un set de impresión que incluya varios planos o vistas 

 
figura 229 

 
3. Asignar un nombre al set 
4. En el listado, seleccionar las vistas o planos a exportar al DWF 

 
Los archivos DWF generados por Revit, se visualizan con el programa Desing Review. 
Igual que otros archivos DWF generados por otras aplicaciones de Autodesk, también se 
les puede colocar marcas de revisión que luego podrán ser cargadas en las vistas de 
hojas por Revit. 
 
Las marcas de revisión en Design Review, se deben colocar sobre planos (sheets) 
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Para cargar las marcas de revisión en Revit: 
 

1. Escoger Pestaña Insert => Panel Link =>  
2. Seleccionar  la vista, en el listado de vistas incluyen marcas de revisión 

 
 
Para controlar las marcas de visualización en un plano:  
 

1. Activar el cuadro de dialogo Visibility/Graphics 
2. Activar la pestaña Imported Categories 

 

 
figura 230 

 
3. En el listado de marcas de revisión desactivar o activar la visualización 

 
Para controlar el estado de una marca de revisión: 
 

1. Activar la vista de plano 
2. Seleccionar la marca de revisión 
3. En las propiedades de instancia, bajo los parámetros Identity Data, podrá cambiar 

el estado, agregar notas y revisar el historial 
 

 
figura 231 

 
Para eliminar la liga de un proyecto con el archivo DWF 
 

1. Escoger pestaña Insert => panel Link => icono  (Manage Links) 
2. Activar la pestaña DWF Markups 
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figura 232 

 
3. Presionar el botón Remove 

 
Para cargar un archivo DWF a Autodesk 360: 
 

Exportación de vistas y proyectos 
 
Revit permite exportar tanto vistas 2D como 3D a otros formatos de dibujo, imágenes o 
bases de datos. 
 
Las extensiones de archivos a las cuales se puede exportar información del proyecto son: 
 

 DWG de AutoCAD tanto vistas 2D como 3D 

 DGN de Microstation tanto vistas 2D como 3D 

 Tablas de cuantificación a formatos de texto 

 Imágenes y caminatas a archivos de animación (AVI) 

 El proyecto a base de datos  de Microsoft Access 

 FBX para 3D Max 

 Building Site ADSK, formato de intercambio para aplicaciones de ingeniería civil 

 Formatos SAT, para intercambio con aplicaciones CAD que trabajan con sólidos 
 
Para exportar información desde Revit a formatos DWG 
 

1. Escoger icono  => Export => CAD Formats => opción DWG 
2. En la caja de dialogo DWG Export, Desplegar la  casilla Select Export Setup 
3. Escoger el formato de exportación requerido o crear uno nuevo. 

4. Para crear un formato de exportación, hacer clic sobre el icono (New Export 
Setup) 

5. En la pestaña Layers, bajo la columna Category se muestra el listado de todas las 
categorías existentes en Revit 

6. Bajo la columna Layer, se muestra el nombre de la capa en la cual se colocaran 
los objetos de acuerdo a su categoría. Se puede modificar el nombre del layer y el 
color. 
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figura 233  

 
7. En la pestaña Solids, escoger si los objetos se exportan como sólidos o mallas. 

Esta opción aplica sobre las vistas 3D 
 

 
figura 234 

 
8. En la pestaña Units & Coordinates, escoger las unidades de medida para 

exportación 
 

 
figura 235 

 
9. Presionar el botón Ok para salir del cuadro de dialogo de formatos de exportación 
10. En el cuadro de dialogo DWG Export y presionar el botón Siguiente 
11. En la casilla Tipo de archivo, escoger la versión de AutoCAD en la cual se quiere 

guardar el archivo. 
12. Cuando la opción Export views on sheets and links as external references está 

activa, en AutoCAD las vistas se colocan sobre layouts y el dibujo (del entorno 
modelo) queda ligado como una referencia externa. 
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figura 236 

  

Importación y liga de archivos 
 
En Revit, se pueden importar datos de dibujos creados en otros programas CAD, como   
El DWG de AutoCAD,  el DXF y los archivos del DGN de MicroStation estos se pueden 
importar directamente en 3D o en 2D. Además las imágenes, tales como bmp y jpeg se 
pueden importarse y tratarse como fondos para dibujar sobre de ellas o utilizarse como 
texturas para ligarse a los elementos.   
  
Cuando se importa un dibujo en una visión 3D, el dibujo aparece en todas las vistas.  Éste 
es el método recomendado de importación si su intención es considerar los datos 
importados en todas las vistas 
 
Si se importan dibujos 2D estos datos solo se pueden importar en la vista actual.  Si se 
selecciona esta opción, los datos importados serán visibles solamente en la visión en la 
cual fue importada.     
 
Se puede explotar la Geometría Importada Después de importar un archivo dentro de 
Revit, entonces así se obtiene entidades separadas. Revit puede descomponer líneas, 
curvas, y texto.  En Revit, la geometría explotada es cambiada a líneas.   
 
Para importar archivos: 
 

1. Escoger pestaña Insert => Panel Import 
2. Escoger el icono correspondiente dependiendo del tipo de archivo a importar. 

 

 
figura 237 

 
Revit permite ligar archivos de DXF y de DWG en el proyecto. A diferencia de un archivo 
que se importa un archivo ligado reduce el espacio de disco para el proyecto, además el 
archivo ligado puede actualizarse al momento de cambiar el archivo origen.  
 
Para ligar archivos DWG: 
 

1. Escoger pestaña Insert => Panel Link 
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2. Escoger el icono  (Link CAD) 
3. Buscar y seleccionar el archivo DWG a importar 
4. En las opciones de importación definir las opciones de importación 

 

 
figura 238 
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